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About this book

The IBM® Rational® License Management Guide provides comprehensive
information about Rational Common Licensing (powered by FLEXIm software) for
IBM Rational products for Windows®, Linux®, and UNIX® systems. Rational
Common Licensing provides the following benefits:

* Enforce license compliance across the enterprise.

* Purchase fewer licenses, because licensing needs are based on actual use and not
the number of PCs.

* Serve license keys for IBM Rational Software Development Platform
products-both Team Unifying version 7.0 and Software Development Platform
version 7.0 products built on the Eclipse framework—from the same license
server.

Note: For Rational Software Development Platform version 7.0 products built on
the Eclipse framework, the enablement of Rational Common Licensing and
floating licenses on desktops is an optional feature allowing administrators
to easily manage and enforce licensing across the enterprise.

The Guide provides you with the technical information you need to:

* Request and install floating, named-user floating, and authorized user license
keys.

¢ Install and configure the Rational license server software on Windows and UNIX
servers.

* Troubleshoot problems related to licensing IBM Rational products.

This manual is divided into two sections: license server setup tasks and client
setup tasks.

* If you are licensing Rational products on a desktop or using floating licenses
from a Rational license server, use the client setup section.

* If you are the license administrator or a user who manages the license keys, use
the license server setup section to request permanent license keys, set up the
license server (if your company has purchased floating licenses), and use
advanced features.

Who should read this book

This guide is intended for system administrators. Desktop users can also use the
information on setting up their clients to request floating licenses. This book
assumes:

* Desktop users have knowledge of Microsoft® Windows and its conventions.

* Administrators have knowledge of Microsoft Windows and its conventions and
also knowledge of UNIX operating systems, and experience with client/server
environments.

Typographical conventions

This manual uses the following typographical conventions:
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ccase-home-dir represents the directory into which Rational ClearCase, Rational
ClearCase LT, or Rational ClearCase MultiSite has been installed. By default, this
directory is /opt/rational/clearcase on the UNIX system and Linux, and
C:\Program Files\Rational\ClearCase on Windows.

cquest-home-dir represents the directory into which Rational ClearQuest has been
installed. By default, this directory is /opt/rational/clearquest on the UNIX
system and Linux, and C:\Program Files\Rational\ClearQuest on Windows.

Bold is used for names the user can enter; for example, command names and
branch names.

A sans-serif font is used for file names, directory names, and file extensions.

A serif bold font is used for GUI elements; for example, menu names and
names of check boxes.

Italic is used for variables, document titles, glossary terms, and emphasis.

A monospaced font is used for examples. Where user input needs to be
distinguished from program output, bold is used for user input.

Nonprinting characters appear as follows: <EOF>, <NL>.

Key names and key combinations are capitalized and appear as follows: Shift,
Ctrl+G.

[ ] Brackets enclose optional items in format and syntax descriptions.

{ } Braces enclose a list from which you must choose an item in format and
syntax descriptions.

| A vertical bar separates items in a list of choices.

... In a syntax description, an ellipsis indicates you can repeat the preceding item

or line one or more times. Otherwise, it can indicate omitted information.

Note: In certain contexts, you can use “...” within a pathname as a wildcard,
similar to “*” or “?”. For more information, see the wildcards_ccase
reference page.

If a command or option name has a short form, a “slash” ( / ) character
indicates the shortest legal abbreviation. For example:

1sc/heckout

Contacting IBM Customer Support for Rational software products

X

If you have questions about installing, using, or maintaining this product, contact
IBM Customer Support as follows:

The IBM software support Internet site provides you with self-help resources and
electronic problem submission. The IBM Software Support Home page for Rational
products can be found at Ihttp: / /www.ibm.com/software/rational /support/ I

Voice Support is available to all current contract holders by dialing a telephone
number in your country (where available). For specific country phone numbers, go
to |http:/ / www.ibm.com/planetwide /|

Note: When you contact IBM Customer Support, please be prepared to supply the

following information:

* Your name, company name, ICN number, telephone number, and e-mail
address

* Your operating system, version number, and any service packs or patches
you have applied

* Product name and release number

IBM Rational : License Management Guide
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* Your PMR number (if you are following up on a previously reported
problem)

Downloading the IBM Support Assistant

The IBM Support Assistant (ISA) is a locally installed serviceability workbench that
makes it both easier and simpler to resolve software product problems. ISA is a
free, stand-alone application that you download from IBM and install on any
number of machines. It runs on AIX, (RedHat Enterprise Linux AS), HP-UX,
Solaris, and Windows platforms.

ISA includes these features:
* Federated search

* Data collection

* Problem submission

* Education roadmaps

For more information about ISA, including instructions for downloading and
installing ISA and product plug-ins, go to the ISA Software Support page.

IBM Support Assistant: [http:/ /www.ibm.com /software /support/isa/|

About this book X1
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Summary of changes

This edition includes the following changes:

* [Chapter 11, “Changing license usage order,” on page 81| :

— In(Table 17 on page 81} the list of the default license usage order has been
updated.

* [Chapter 2, “Requesting license keys,” on page 13}

— In|“Accessing the IBM Rational License Key Center” on page 13/instructions
for accessing the License Key Center, the new online license fulfillment and
management tool, have been added.

— In|[‘Migrating existing license keys to the License Key Center” on page 13)
instructions have been added for migrating AccountLink-derived license keys
to the new License Key Center.

— In[‘Using the License Key Center to request permanent license keys” on page]
15, information about functions in the License Key Center have been added.

* [Chapter 3, “Configuring a license server for Windows systems,” on page 19

— Throughout the chapter, information has been added regarding license server
support for floating license keys for the IBM Rational Software Development
Platform (SDP).

* |Chapter 4, “Configuring a UNIX license server,” on page 35|

— Throughout the chapter, information has been added regarding license server
support for floating license keys for the IBM Rational Software Development
Platform (SDP).

* Appendix: The Trademarks section of Notices page has been updated.

© Copyright IBM Corp. 1999, 2007 xiii
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Part 1. License server setup
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Chapter 1. Before requesting license keys

This chapter describes IBM Rational Common Licensing (powered by FLEXIm
software) and supported configurations. Rational uses a software-based license
management tool called FLEXIm from Macrovision Corporation. This software
allows vendors, such as IBM, to build a customized licensing model.

This information will help you plan the licensing configuration for your

environment.

Note: Rational Common Licensing is an optional licensing enforcement feature for
Rational Software Development Platform tools.

Note: Rational Common Licensing (powered by FLEXIm software) support for
version 7.0 Rational Software Development Platform products built on the
Eclipse platform is enabled in a new release of Rational License Server
software. The new version of Rational License Server software serves both
previous Rational Common Licensing enabled Team products (Rational
ClearCase, Rational ClearQuest, etc.) as well as the new Rational 7.0
products. If you need to serve both the Rational version 7.0 desktop
products and the version 7.0 Team products, you must upgrade to the latest
version of the License Server software. Two separate servers are not required
since this new version of the server supports the previous clients as well as

the new Rational 7.0 clients.

Getting started with IBM Rational Common Licensing

[Table 1| and [Table 2| help you find procedures for administrator licensing tasks.

Table 1. Getting started with IBM Rational Common Licensing

Task

Procedure

Upgrade license keys.

[“Upgrading license keys” on page 11}

Get the permanent license key for the
product.

If you have purchased authorized user, floating,
or named-user floating licenses, use your Proof
of Entitlement certificate to request permanent
license keys from Rational License Key Center,
the Web-based license key management tool. See
[Chapter 2, “Requesting license keys,” on page 13|
for more information. If there is a delay in
receiving your permanent authorized user or
floating license keys, use the temporary license
key on the Proof of Entitlement certificate. See
“Using your Proof of Entitlement certificate” on|

page 4]

Get an evaluation license key for the
product.

Your IBM sales representative sends you an
evaluation license key.

Install authorized user license keys on
your desktop.

Chapter 9, “Installing authorized user license|
keys,” on page 71|

Install the floating and named-user
floating keys on the Rational license
server for Windows.

Chapter 3, “Configuring a license server for|
Windows systems,” on page 19
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Table 1. Getting started with IBM Rational Common Licensing (continued)

Task

Procedure

Install the floating keys on the Rational

Chapter 4, “Configuring a UNIX license server,”

license server for UNIX systems.

on page 35|

references additional tasks and information that may suit the needs of your

users.

Table 2. Optional or additional tasks

Task

Procedure

Windows servers.

Configure redundant license servers on

“Setting up redundant Windows license servers|

(optional)” on page 32}

UNIX servers.

Configure redundant license servers on

“Setting up redundant UNIX servers (optional)’]

on page 4(]

Remove the Rational license server

“Removing the Rational License Server software]

software from a Windows server.

for Windows” on page 34

software from a UNIX server.

Remove the Rational license server

“Removing the UNIX license server software” on|

page 42]

home or traveling.

Use floating license keys for working at

“Using license keys for home use or travel” on|

[page 69l

Combine license files from multiple

Do not combine license key files from multiple

vendors. vendors; instead, keep the license keys in
separate files.
Understand license installation * [“Administrator Privileges for the LKAD” onl

problems and error messages.

[page 68|

+ |Chapter 7, “Troubleshooting licenses,” on page|
5

Chapter 6, “Understanding IBM Rational|
Common Licensing components,” on page 51}

Understand the mechanics of IBM
Rational Common Licensing.

Using your Proof of Entitlement certificate

The IBM Proof of Entitlement certificate (PoE) is a document that IBM sends to
customers who purchase software products. The PoE confirms to you the eligible
products and level of use for which you are authorized. It includes important
order information such as your IBM customer number, IBM site number, and IBM
order number. By default, IBM sends the PoE by e-mail to the Primary Site Contact
on the order from the e-mail account "Passport_Advantage@ibm.com.” The e-mail
subject line is either "IBM Passport Advantage Proof of Entitlement” or "IBM
Passport Advantage Express Proof of Entitlement.”

The information, especially the account number, on this certificate verifies that
your company has purchased licenses to operate IBM Rational products.

* To get your Authorized User, Authorized User Fixed Term License (FTL), or
floating license keys, supply information from your PoE certificate to the License
Key Center. See [Chapter 2, “Requesting license keys,” on page 13| for more
information about the License Key Center.

« If you have purchased an IBM Rational XDE" product, the single-string desktop
key on the PoE is your permanent license. Do not order a permanent license key
from License Key Center. Optionally, you can enable floating license enforcement
for Rational XDE.
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* To evaluate most IBM Rational products, you can obtain a temporary key from
your sales representative.

* To evaluate an IBM Rational product based on the Eclipse framework, download
the product. Depending on the product, you will have 30 to 60 days to evaluate
the product. After evaluation, either purchase a permanent activation kit or
implement Rational Common Licensing.

* If you are unable to access the License Key Center or there is a delay in
receiving your permanent keys, type the temporary license key from your PoE
into the License Key Administrator (LKAD).

Opening the License Key Administrator (LKAD)

The IBM Rational License Key Administrator (LKAD) is installed with many IBM
Rational products and with your Rational License Server software. This application
provides an interface to IBM Rational Common Licensing (powered by FLEXIm
software). Use the LKAD or the LKAD wizard to enter or import license keys and
change your license configuration.

Note: For IBM Rational products built on the Eclipse framework, use the IBM
Installation Manager to manage your license configuration on the desktop.
* To access the LKAD and the LKAD wizard on a desktop, click Start >
Programs > IBM Rational > Rational License Key Administrator.
e To access the LKAD and the LKAD wizard on the license server, click Start >

Programs > IBM Rational > Rational License Server > Rational License Key
Administrator.

Note: You must have administrative privileges on the computer before you can
enter or import license key information in the LKAD.

To access the Help, click Help in the License Key Administrator’s main menu, click
Help in the LKAD wizard, or open <Install Path>\1BM Rational\doc\help\
Ticadmin\index.htm.

Using the LKAD after product installation

With the Setup wizard you can launch the Rational License Key Administrator
(LKAD) and LKAD wizard after the product installation finishes.

On a desktop, use the LKAD to:

* Import a authorized user license file.

* Enter a temporary authorized user license key.

* Specify a license server to request floating licenses.

* Go to License Key Center to request permanent license keys.

Note: For IBM Rational products based on the Eclipse framework, use the IBM
Installation Manager to manage your license configuration on the desktop.

On a license server, use the LKAD to:

¢ Import a floating or named-user floating license key.

* Enter a temporary floating license key.

* Go to the License Key Center to request permanent license keys.

Chapter 1. Before requesting license keys 5



Defining the “user” in IBM Rational Common Licensing

IBM Rational Common Licensing (powered by FLEXIm software) checks out
licenses on behalf of a “user.” The “user” is defined as follows:

¢ On Windows, the “user” is the Windows operating system log on ID.

* On UNIX, a “user” is the account name of the person running the UNIX shell.

¢ On Web products, the “user” is the product logon ID.

Defining license types
explains types of licenses.

Table 3. License types

6

License type

Products

Description

Authorized user

All products included
in Rational Common
Licensing.

An authorized user license (formerly
called a node-locked license) is created
for a specific desktop. It allows a user to
run an IBM Rational product only on that
specified desktop.

The user may run multiple sessions of a
product concurrently on the specified
computer using a single license key.

Because authorized user licenses are
uncounted licenses, no license server is
needed to manage them.

Authorized user
fixed term license
(FTL)

Available for many
IBM Rational software
products

An IBM Rational Authorized User FTL
allows a single, specific individual to use
an IBM Rational product for a specific
length of time (the term).

Purchasers must obtain an Authorized
User FTL for each individual user
accessing the product in any manner.

An Authorized User FTL may not be
reassigned unless the purchaser is
replacing the original assignee on a
long-term or permanent basis.
Currently, this license type is not
available for IBM Rational products
based on the Eclipse framework.
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Table 3. License types (continued)

License type

Products

Description

Floating

All products included
in Rational Common
Licensing.

* A license administrator installs the
Rational license server software on single,
multiple, or redundant servers. The
administrator then installs the floating
licenses on the license servers. These
floating licenses are created for the
specific license server.

¢ Client desktop users obtain licenses from
the license server when they run a copy
of the software. One license is granted
per client per product, except
performance testing products.
Performance testing products can check
out multiple licenses.

¢ Floating licenses allow anyone on your
network to use IBM Rational products
while a license is available. Thus, the
number of licenses that you purchase and
register in License Key Center determines
the maximum number of users who can
use IBM Rational products concurrently.

Named-User
Floating

* Rational
PureCoverage®

* Rational Purify®

* Rational Quantify®

* Similar to a floating license, except the
license administrator assigns licenses to
specific users. That is, only specific users
can request floating license keys from the
license server.

* A named-user floating license requires a
license administrator to create a list of
authorized users.

Defining license key types

Floating, named-user floating, or authorized user licenses can be permanent and

temporary keys.

The following table defines the license key types used in IBM Rational Common

Licensing (powered by FLEXIm software).

Table 4. License key types

License key type

Description

Permanent

A license issued to a customer to run products for an
indefinite period of time.

* To order your permanent floating, named-user
floating, or authorized user license keys for most
products, use the Rational License Key Center.

* To acquire an authorized user license key for IBM
Rational products based on the Eclipse framework,
purchase and download an activation kit from
Passport Advantage.

See [Chapter 2, “Requesting license keys,” on page 13| for

Center.

information about ordering keys from the License Key
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Table 4. License key types (continued)

License key type Description
Temporary (evaluation or * A time-limited license issued to a customer for
emergency) running IBM Rational products. You can use it on any

computer until the specified expiration date.

* Temporary license keys can be floating or authorized
user.

* Temporary keys are generated only for single or
multiple license servers. They are not generated for
redundant servers.

* To evaluate a product, ask your sales representative
for an evaluation key.

TLA (Term License Agreement)

TLAs allow users access to IBM Rational software for
a negotiated period of time. The expiration date is
built into the license key.

* TLA license keys can be floating or authorized user.

* The processes of requesting and installing TLA license
keys are the same as requesting and installing
permanent licenses.

* To order your TLA floating, named-user floating, or
authorized user license keys, use
License Key Center. See [Chapter 2, “Requesting]
[license keys,” on page 13| for more information about
Rational License Key Center.

Using point-product keys and suite keys

8

This section explains situations in which products use multiple license keys and
cases in which multiple products use one license key.

Using multiple license keys

A desktop user can check out multiple floating or authorized user license keys.

Using ClearCase LT

ClearCase® LT can use either a ClearCase LT floating license or a Rational Suite®
(authorized user or floating) license. There is no ClearCase LT authorized user
license.

Using ClearQuest Web and RequisiteWeb

A single user may run the IBM Rational ClearQuest® native client and Web client
on the same desktop simultaneously with a single floating license key while the
user’s Windows login ID is the same as the user’s ClearQuest login ID. The same
logic applies to IBM Rational RequisitePro® native client and Web client. See
[‘Defining the “user” in IBM Rational Common Licensing” on page 6]

Using suite license keys

A license key indicates whether it is a Rational Suite license, such as Rational Suite
Enterprise. An Rational license file can contain multiple suite and individual
product license keys.
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A Rational Suite license key lets you run all of the products contained within a
Rational Suite at the same time on a single computer. Any add-on product, such as
Rational XDE, uses its own license key instead of the Rational Suite license key.

Using a different suite license from the suite edition installed
You can install a Rational Suite on a desktop and specify that products within the
Suite check out a different type of Rational Suite license. For example, you can
install Rational Suite Enterprise on the desktop and have the products within the
Rational Suite check out a Rational Suite AnalystStudio® license from the license
server.

To select a different license for a product, use the License Key Administrator on the
client desktop. See [Chapter 11, “Changing license usage order,” on page 81| for
more information.

Using license keys for the Rose variant installed

Rational Rose uses a license key for the variant of Rose that you install, or a
Rational Suite key that includes that Rose variant.

Table 5. License keys for Rose variant

Variant Variant license key:

Rational Rose Enterprise Edition « Rose Enterprise

* Rational Suite Enterprise

* Rational Suite DevelopmentStudio for Windows

Rational Rose Modeler Edition Rose Modeler
Rational Rose Professional Data « Rose Data Modeler
Modeler

* Rational Suite AnalystStudio

Rational Rose for UNIX « Rose for UNIX

* Rational Suite DevelopmentStudio for UNIX
* Rose Enterprise for UNIX

Using license keys on different platforms

Rational Rose can run with license keys specified for different platforms. To do
this, change the license usage order on your computer. See [Chapter 11, “Changing]
[license usage order,” on page 81| for more information.

* Rational Rose for UNIX runs with a Rational Rose Enterprise for Windows key.

* Rational Rose Enterprise for Windows runs with a Rational Rose for UNIX key.

Using ClearCase and ClearCase MultiSite license keys

IBM Rational ClearCase version 7.0 extends support for IBM Rational Common
Licensing to Rational ClearCase and IBM Rational ClearCase MultiSite®.

With this release you can use either ClearCase licensing (formerly known as Atria
licensing) or Rational Common Licensing (powered by FLEXIm software). In
previous releases, Rational Common Licensing was supported only for use with
Rational ClearCase LT. If you want to use Rational Common Licensing, select this
option in the Site Preparation Tool or dynamically switch license modes after
installation.
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Review the information and procedures in this guide to understand the license
management tools, license key types, and how to set up your license server
configuration and import license keys. For more information about installing and
configuring Rational ClearCase, see the IBM Rational ClearCase, ClearCase MultiSite,
and ClearCase LT Installation and Upgrade Guide.

ClearCase MultiSite license keys

Rational ClearCase MultiSite requires both a ClearCase license key and a ClearCase
MultiSite license key. This licensing model is similar to IBM Rational ClearQuest
MultiSite, as explained in [“Using ClearQuest MultiSite license keys” on page 10}

Using ClearQuest MultiSite license keys

Rational ClearQuest MultiSite requires both a ClearQuest license and a ClearQuest
MultiSite license. Any access to a replicated database requires both a ClearQuest
license key and a ClearQuest MultiSite license key.

You can calculate the number of Rational ClearQuest MultiSite licenses your site
needs by determining how many developers will access replicated databases. If all
of your developers will access replicated databases, you need the same number of
Rational ClearQuest MultiSite licenses as Rational ClearQuest licenses. If not all
developers will access replicated databases, you can purchase fewer Rational
ClearQuest MultiSite licenses.

For example, a company has two sites, with 20 developers at site A and 5
developers at site B. The company has three databases at site A; two of them will
be replicated to site B and one will not be replicated. Five of the developers at site
A will access only the unreplicated database, and the remaining 15 will work in all
databases. All of the developers at site B will access replicated databases.
Therefore, the company needs to purchase the following number of licenses:

Number of Rational ClearQuest | Number of Rational
Site licenses ClearQuest MultiSite licenses
A 20 15
B 5 5

Note: This example assumes that you purchase a Rational ClearQuest license for
each user. If you have fewer Rational ClearQuest licenses than users,
purchase a proportionate number of Rational ClearQuest MultiSite licenses.
For example, if site B purchased three Rational ClearQuest licenses, they
would also purchase three Rational ClearQuest MultiSite licenses.

Using license keys for products built on the Eclipse platform

10

IBM Rational License Server version 7.0.0.1 extends Floating license support for
IBM Rational Software Development Platform tools that are built on the Eclipse
open source framework. This family of products, including IBM Rational
Application Developer, IBM Rational Software Architect, and others version 7.0
and later, includes support for a subset of IBM Rational Common Licensing
(powered by FLEXIm software) that enables administrators to manage and enforce
licensing across the enterprise.

Floating license enforcement is an optional licensing feature for Rational Software
Development Platform tools. You can choose to purchase an Authorized User
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license and download the product activation kit, which contains a permanent
license key. The permanent license key is not provided or managed through
Rational Common Licensing. At any time, you can switch between using an
activation kit permanent license key or using Floating license support. You do this
using the IBM product installation and license management utility, IBM Installation
Manager for the Rational Software Development Platform.

Use the information and procedures in Part 1, |Part 1, “License server setup,” on|
page 1)to learn about Floating licenses, obtain floating license keys, and install
Rational License Server. Refer to Part 3, [Part 3, “Client setup for Rational Software|
[Development Platform software,” on page 89, to learn about implementing
Floating license support on client desktops.

Upgrading license keys

If you are upgrading from an earlier version of an IBM Rational Suite or
point-product, for example version 2003.06.00, re-use your current Rational Suite
and point-product keys.

You must order new license keys in License Key Center under the following
conditions:

 If you have purchased a different edition of Rational Suite from the one that you
are currently using, return the license file and request a new license file that
includes the new Rational Suite key.

— See|Chapter 12, “Returning or moving keys for desktop users,” on page 87| or
[Chapter 5, “Returning or moving keys for administrators,” on page 49| for
returning the existing key.

- See|Chapter 2, “Requesting license keys,” on page 13| for requesting
permanent or TLA license keys.

* If you are adding a new product to your system, return the license file and
request a new license file that includes the new product license key.

— See|Chapter 12, “Returning or moving keys for desktop users,” on page 87| or
[Chapter 5, “Returning or moving keys for administrators,” on page 49| for
returning the existing key.

— See|Chapter 2, “Requesting license keys,” on page 13| for requesting
permanent or TLA license keys.

* If you have upgraded to a different variant of IBM Rational Rose®, remove the
existing variant and install the new variant and license key.

Using license keys for home use or travel

If your product uses floating keys, with disconnected mode you can use IBM
Rational software at home for a 3-day period. You must activate disconnected use
within a 3 day period of acquiring a floating license key and disconnecting from
the network at work. After you activate disconnected use, you can use the software
for 3 days from the day and time that you activate the disconnected use.

For example, you acquire a floating key for IBM Rational ClearCase LT at 4 p.m.
on Friday and disconnect from the network and go home. Because you plan to
work at home during the next week, you must activate disconnected use within
the 3-day period of acquiring the key and disconnecting from the network. If you
launch ClearCase LT by 3:30 p.m. on Monday, you can use Rational ClearCase LT
until 3:30 p.m. on Thursday. If you do not launch Rational ClearCase LT before 4
p-m. on Monday, you will lose disconnected use of Rational ClearCase LT.
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Disconnected use of floating licenses on a UNIX license server is not supported.

There are two other options for home use or travel:

* Depending on whether it is available for your product, you can use authorized
user keys instead.

* Rational ClearCase LT provides snapshot views. Snapshot views of your work
do not require network connectivity; therefore, a license key is not necessary.

Changing the disconnect time-out to delay disconnected use

If you have a slow network at work, your software automatically goes into
disconnected use mode if it does not receive a response from the license server
within 5 seconds. You then see a window that states that you are in disconnected
use mode after the 5 seconds.

Starting with release 2001A, you can change the time-out period before your IBM
application goes into disconnected use mode. The default setting is 5 seconds. To
change the setting:

1. Create a DWORD key: HKEY_LOCAL_MACHINE\SOFTWARE\IBM
Rational\Licensing\1.0\DisconnectTimeout

2. Modify the value (decimal) to be more than 5 seconds.

IBM Rational licensing configurations

This section describes supported licensing configurations. The term supported
refers to a licensing configuration that Rational has tested and guarantees will
work under normal operating conditions. This applies to configurations that the
software was designed to handle. This also applies to configurations for which the
software was not specifically designed, but with which it will work with some
manual intervention.

lists supported licensing configurations.

Table 6. IBM Rational licensing configurations

Configuration Supported platforms
Authorized user license key Windows/UNIX
Rational license server and Windows Windows

products installed on a single computer.

Rational license server and UNIX UNIX

products installed on a single computer.

Floating or named-user floating licenses | UNIX server serving licenses to Windows clients
for Windows products.

Permanent floating licenses with Windows server serving licenses to UNIX clients
redundant license servers.

Permanent floating licenses with Windows server serving licenses to Windows
redundant license servers. clients

Permanent floating licenses with UNIX server serving licenses to UNIX clients

redundant license servers.
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Chapter 2. Requesting license keys

Permanent floating and authorized user license keys (formerly referred to as
node-locked license keys) are managed through the IBM Rational License Key
Center. You, as the license administrator, can request permanent license keys in the
License Key Center.

The information in this chapter is intended for system administrators or users who
manage licenses. It provides information about requesting and receiving permanent
floating and authorized user license keys from the License Key Center.

Accessing the IBM Rational License Key Center

The Rational License Key Center is the online licensing tool that you use to get or
return your Rational software license keys.

To access the License Key Center:

1. Go to the Rational support [Licensing Web page| at http:/ /www.ibm.com/
software/rational /support/licensing/.

2. Click the IBM Rational Licensing and Download site link, and logon using a
current IBM ID and password. If you do not have an IBM ID, click Register to
create a new one.

3. At the page for Rational Download and Licensing Center, click Log into the
new IBM Rational License Key Center.

4. Log in to the Rational License Key Center.

Migrating existing license keys to the License Key Center

This section provides information to help you move your existing license keys to
the new Rational License Key Center.

License key migration guidelines

Use the following guidelines when managing license keys generated from the
License Key Center.

¢ The License Key Center shows only keys that it generates. It does not show
license keys you received from AccountLink or from IBM before the License Key
Center went online May 2006.

* Review your IBM Rational software deployments throughout your enterprise

and generate keys for all existing products using the License Key Center. This
helps you to better manage your keys through this service.

FLEXIm license keys

Most of the IBM Rational product portfolio uses a license key manager that is
powered by FLEXIm software. These products include IBM Rational Suite, IBM
Rational ClearQuest, IBM Rational Rose, IBM Rational PurifyPlusTM, IBM Rational
Robot, and a series of other products.

When you download license keys from the License Key Center, the downloaded

file does not contain license keys for your host that you received before the License
Key Center went online in May 2006. If you import this file onto your existing

© Copyright IBM Corp. 1999, 2007 13


http://www.ibm.com/software/rational/support/licensing/

14

Windows or UNIX basedRational license server, the import feature will replace
your existing license key file with the keys in the file. This means you must use
the License Key Center to generate new keys to replace your existing keys that you
received from IBM before May 2006.

Suppose a customer received 50 Rational Rose keys and 75 Rational Robot keys for
host XYZ using the earlier AccountLink license key fulfillment system.

Next, suppose that the customer wants to add 100 Rational ClearQuest keys for the
same host, XYZ. The customer accesses the Rational License Key Center, and
generates 100 Rational ClearQuest keys for host XYZ.

The file that is downloaded from the License Key Center for host XYZ will not
contain the Rose and Robot license keys, because those keys came from
AccountLink. Importing the file from the License Key Center will overwrite the
existing license key file on the disk with the file that contains only the Rational
ClearQuest license keys.

In this scenario, importing 100 Rational ClearQuest keys to host XYZ will replace
the existing Rational Rose and Rational Robot license keys from AccountLink for
host XYZ.

The result is that the license server manages the Rational ClearQuest keys only.
To prevent this situation, the customer must go to the License Key Center, and

generate Rose and Robot keys for host XYZ. The license key file will then include
all three keys for host XYZ:

License key file downloaded from the License Key Center for host XYZ:
* 100 Rational ClearQuest keys

* 50 Rational Rose keys

* 75 Rational Robot keys

Downloading and importing this file from the License Key Center will overwrite
the two existing Rational Robot and Rational Rose keys with the desired three keys
for Rational Robot, Rational Rose, and Rational ClearQuest.

If the customer adds another license key for Rational PurifyPlus to this host, the
License Key Center issues a file that has all four license keys. Importing this file
also yields the correct results.

Rational ClearCase license keys

The Rational License Key Center shows two types of license keys for Rational
ClearCase: "classic" Rational ClearCase keys, and Rational ClearCase keys based on
FLEXIm software. The License Key Center indicates the license key type in the
name of the key.

The term "classic” Rational ClearCase license keys refers to the proprietary license
manager that Rational ClearCase has used. The manager is also referred to as the
"Rational ClearCase license manager." This license manager supports Rational
ClearCase through version 7.0.

Version 7.0 offers the choice of using the classic Rational ClearCase license
manager or using Rational Common Licensing, powered by FLEXIm software. The
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benefit of using the license manager based on FLEXIm is that you can have a
single Rational license server manage your Rational ClearCase, Rational
ClearQuest, and other IBM Rational product license keys using Rational Common
Licensing.

Generating classic Rational ClearCase license keys

When you generate a classic license key for Rational ClearCase, the License Key
Center gives you the license key that you generated plus all other Rational
ClearCase keys that you have previously generated for that host using the License
Key Center.

For example, the first time a customer generates a classic Rational ClearCase key
for host ABC, the License Key Center shows the following key:

-Ticense ClearCase RATL *.2 NONE 44561c.dac92b9f.02

If the customer returns to the License Key Center and obtains another classic
Rational ClearCase key for the same host, the License Key Center now shows the
new key in addition to the previously generated key:

-Ticense ClearCase RATL *.7 NONE 88261c.dac92b9f.08
-Ticense ClearCase RATL *.2 NONE 44561c.dac92bh9f.02

When you install the new Rational ClearCase keys, always replace your installed
license keys with the keys that the License Key Center shows for your host.

Using the License Key Center to request permanent license keys

In the License Key Center, you can order and return permanent authorized user,
floating, and named-user floating license keys for Windows, Linux, and UNIX
products. For more information about license types, see [“Defining license types”|
_on page 6|

Note: The License Key Center does not support temporary license key
transactions. (Contact your sales representative for more information about
license key transactions.)
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The License Key Center offers a range of license key management transactions:

Transaction

Description

Generate license keys

Request your permanent license key. To order a permanent
key, you need your Proof of Entitlement certificate, the host
name and host ID, or Ethernet address of the license server
or desktop PC.

You can register:

* IBM Rational products on Windows or UNIX that will be
served from a license server.

 Single, multiple, or redundant license servers on Windows
or UNIX operating systems.

* Remote Windows or UNIX computers; you do not need to
sit at the computer you are requesting license keys for.

To find out more about the host name and host ID, see
[“Finding the host ID” on page 17 To order permanent
license keys for a redundant server environment, specify in
the following order the host IDs for the redundant server:

* Primary license server
* Secondary license server

e Tertiary or back up license server

The clients communicate with the redundant servers in that
order.

Move your license keys

Return an existing license key to your account and then
request a license key for a new desktop or server. This
adjusts the count of registered products in your account and
enables you to receive a license key for the new computer.
To learn more about returning license keys, see IE fhapter 5,|
[“Returning or moving keys for administrators,” on page 49|

View your Sales Orders

The View order history page shows you all the Sales Orders
that are associated with your account. You can click the
Sales Order Number to view details about the order.
Clicking the License keys for this order hyperlink enables
you to generate keys associated with your order.

View your installed keys

The View keys by host page displays a complete list of hosts
that currently have installed keys that were generated from
the specified account.

Add other members to your
account

The Account members page shows a list of users who are
members of your account along with each member’s e-mail
address, title, and privileges. The same user can be a
member of multiple accounts with differing privileges across
accounts.

Add yourself to other
accounts

It is possible that your company has multiple License Key
Center accounts that you need to access. To do this, you
have two options: the account administrator of the account
you want to access can add you as a member or you can
add yourself to the new account.

Switch between accounts

If you are a member of multiple IBM Rational License Key
Center accounts, the Switch account link is displayed in the
left menu.
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Finding the host ID

The term host ID is a generic term that specifies the computer hard disk drive
serial number or Ethernet address (network ID).

With IBM Rational Common Licensing (powered by FLEXIm software), the default
host ID value on Windows computers is the serial number of the startup hard disk
drive. In this case, the host ID field is: DISK_SERIAL_NUM=nnnnnnn. Example:
DISK_SERIAL_NUM=12345678.

The default host ID value on UNIX computers is the Ethernet address of the
system written in this format: HOSTID=nnnnnnnnnnnn. Do not confuse the format
HOSTID=nnnnunnnnnnn with the hard disk drive serial number format
DISK_SERIAL_NUM=nnnnnnnn that is referred to in Rational documentation, online
Help, and License Key Center as the host ID.

A single key cannot contain multiple values for a host ID.

Finding the host ID on a Windows computer

To get the host name, host ID, or Ethernet address of a Windows computer, click
License Keys > Host Data in the License Key Administrator menu.

Note: If IBM Rational software is not installed on the license server or client,
License Key Center provides a tool to help you find this information.

Accommodating frequent host ID changes

Registering the host ID of the startup hard disk drive might not be possible if you
have dual boot systems, if you frequently reformat your disks, or if you ghost your
hard disk images. These processes change the host ID of the startup drive. Because
the products and license keys are registered to a specific host ID, you cannot use
your IBM Rational products if the host ID changes.

To avoid this situation, use one of the following methods:
* Use Floating licenses that are served by a license server with a constant host ID.
* Use the address of the Ethernet card in the computer as a host ID.

Note: You do not need to add this setting if you have installed release 2001 (or
later) of IBM Rational products and release 2001 (or later) of the license
server.

On Windows computers, the License Key Administrator (LKAD) can be forced

to use the Ethernet address instead of the hard disk drive serial number. This

allows the LKAD to import the license key file correctly. Add the registry setting

“UseNIC=TRUE"” to HKEY_LOCAL_MACHINE\SOFTWARE\Rational

Software\Licensing\1.0.

* Make sure that, when images are created to refresh the computer, you keep the
hard disk drive serial number of the startup drive constant.

Finding the host ID on a UNIX system server
Use one of the following methods to find the host ID:

e If the license server software is installed, use the Imhostid command to find the
Ethernet address of the server.

* On Sun computers, type Imhostid at the prompt. This command returns the
value of the Sun host ID.
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Requesting license keys without an internet connection or License
Key Center availability

This section summarizes the steps for getting a permanent license key when you

do not have an internet connection or when License Key Center is unavailable.

1. Print the license request form. To print the form, either install the IBM Rational
product and open the license request form in the Rational common directory.
(The Chinese, French, German, and Japanese versions of this fax form are in the
same location.)

* <Rational_directory>\common\License Fax Form - English.htm

* <Rational_directory>\common\License Fax Form - Chinese.htm

* <Rational_directory>\common\License Fax Form - French.htm
German.htm

* <Rational_directory>\common\License Fax Form
* <Rational_directory>\common\License Fax Form

Japanese.htm

2. Use the Proof of Entitlement certificate to complete the form. Make sure that
the contact, account number, product, licensing, and host details are correct.
Errors will cause delays in receiving your license keys.

3. Fax the request to IBM.

Call IBM support for Rational products if you cannot use License Key Center or
the fax form to order your permanent license keys.

Receiving permanent license keys

After you order your keys in License Key Center, a Rational license file is
generated. Download this file by clicking the Download Keys button in the
License Key Center.

If you request a permanent license key by fax and you have specified an e-mail
address in your contact information, you will receive a license key file by e-mail.
You can copy the permanent license file from the e-mail enabled computer and
install it on the computer that is not e-mail enabled.

If you cannot provide an e-mail address, contact IBM support for Rational
products.

After you receive the license key file:

* Import the floating or named-user floating license key file on the license server.
For more information about importing a license key file on a license server, see
Chapter 3, “Configuring a license server for Windows systems,” on page 19| or
Chapter 4, “Configuring a UNIX license server,” on page 35}

* Import the User Authorized license key file on the desktop. See
[“Installing authorized user license keys,” on page 71|
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Chapter 3. Configuring a license server for Windows systems

Using floating licenses you can manage and maintain licenses on single, multiple,
or redundant license servers.

This chapter describes how to set up and run Rational license servers for the
Windows operating system. The information in this chapter is intended for system
administrators or users who manage licenses. If you are using desktop licenses, see

[Chapter 9, “Installing authorized user license keys,” on page 71}

Some of the tasks in require knowledge of the Windows operating system
and IBM Rational Common Licensing (powered by FLEXIm software).

Note:

Note:

© Copyright IBM Corp. 1999, 2007

Rational Common Licensing (powered by FLEXIm software) support for
version 7.0 Rational Software Development Platform products built on the
Eclipse platform is enabled in a new release of Rational License Server
software. The new version of Rational License Server software serves both
previous Rational Common Licensing enabled Team products (Rational
ClearCase, Rational ClearQuest, etc.) as well as the new Rational 7.0
products. If you need to serve both the Rational 7.0 desktop products and
the 7.0 Team products, you must upgrade to this latest version of the license
server. Two separate servers are not required since this new version of the
server supports the previous clients as well as the new Rational 7.0 clients.

For Rational Software Desktop Platform version 7.0 products built on the
Eclipse framework, the enablement of Rational Common Licensing and
floating licenses on desktops is an optional feature allowing administrators
to easily manage and enforce licensing across the enterprise.
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Setting up floating licenses for Windows servers

20

The steps required to set up floating and named-user floating license keys are

described in

Table 7. Guide to setting up floating licenses for Windows servers

Task

Procedure

Set up floating licenses

Understand the IBM Rational Common
Licensing model. See [Chapter 1, “Before|
[requesting license keys,” on page 3|

Request and receive permanent license keys.
See |Chapter 2, “Requesting license keys,” on|
IEage 13| If you are evaluating the product,
use the temporary license keys.

Make sure that your license server and clients
can work with the network configuration that
you have set up. See |“Working with a|
supported network configuration” on pagel
22

Install the Rational License Server software on
the server. See [“Installing the server software|
lon a Windows server” on page 23}

Install the evaluation or permanent license
keys on the license server. See [“Opening the]
License Key Administrator (LKAD)” on page]
4] and [“Using floating keys on a Windows|
license server” on page 25/

Start the Rational License Server software. See
“Starting the Windows license server” on|

page 22[

Tell client desktop users to specify the license
server in their desktops.

IBM Rational : License Management Guide




Table 7. Guide to setting up floating licenses for Windows servers (continued)

Task

Procedure

Set up named-user floating licenses (only
applies to Purify, Quantify, and
PureCoverage)

* Understand the IBM Rational Common
Licensing model. See [Chapter 1, “Before|
[requesting license keys,” on page 3|

* Request and receive permanent license keys.
See [Chapter 2, “Requesting license keys,” on|
[page 13} If you are evaluating the product,
use the temporary license keys.

* Make sure that your license server and clients
can work with the network configuration that
you have set up. See ["Working with 4]
supported network configuration” on page|
22

* Install the Rational License Server software on
the server. See |[“Installing the server software|
lon a Windows server” on page 23]

* Install the named-user floating license keys

on the license server. See |“Opening tha
License Key Administrator (LKAD)” on page]
4] and |“Using named-user keys on a|
Windows license server” on page 26| If the
keys are temporary, enter the license key
information in the LKAD wizard (You do not
have to edit the rational.opt file.).

» Edit the rational.opt file with the names of
specific users. See [“Using named-user keys on|
la Windows license server” on page 26|

» Start the Rational License Server software. See

“Starting the Windows license server” on|

page 27|

* Tell client desktop users to specify the license
servers in their desktops.

Specify the Rational License Server
software on a Web server

See |“Specifying the license server on Windows|
[Web servers” on page 30}

Use floating licenses with a firewall

See [“Using floating licenses with a firewall” on|

|Eage 33|

Change the Imgrd port

See [“Changing the Imgrd port” on page 34

Configure redundant license servers

See [“Setting up redundant Windows license
|servers (optional)” on page 32|

Use License Key Administrator
commands for configuring license
servers on client desktops

See [“Running the LKAD command line on|
[Windows (optional)” on page 28]

Change the order in which IBM Rational
products use licenses

You cannot use the license server to change the
license usage order for all clients. To change it,
each user will have to go into the License Usage
Mapper in the client LKAD or, for products
built on the Eclipse platform, the Manage
Licenses wizard in the client's IBM Installation
Manager. The order is tied to the user_ID. See
Chapter 11, “Changing license usage order,” on|

page 81|

Modify the time-out period

See [“Modifying the floating license time-out]
[period” on page 31}
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Table 7. Guide to setting up floating licenses for Windows servers (continued)

Task Procedure

Monitoring license server activity See [“License monitoring (optional)” on page 32}

Upgrading the Rational License Server | You can upgrade the License Server software to
software the most current version, but do not run
different versions of License Server software on
the same computer.

Running multiple license servers on the |Run a separate Imgrd instance for each vendor

same server daemon and keep license keys in separate files.
Diagnose problems with the Rational See the following sections:
License Server software .

“Checking the Windows license server” on|

page 62|

* |“Checking the Windows network connection”|

on page 63|

Remove the Rational License Server See ["Removing the Rational License Server|
software [software for Windows” on page 34|

Working with a supported network configuration

22

This section provides important information about network configurations.

Dial-up support

You can use floating licenses with a dial-up network connection that supports a
constant TCP/IP connection to the Rational License Server software. All clients
must have a constant TCP/IP connection to the license server.

If the dial-up connection is lost while a client has checked out a floating license,
the server will automatically reclaim the floating license. When the connection is
lost, the client cannot periodically “talk” to the license server to refresh its license.
Because the client cannot refresh its license, the Rational product runs for a limited
period of time. This time period is product dependent.

WAN support

Novell

Rational floating licenses can be used over a wide area network if this is in
compliance with the geographical allowance of the License Agreement.

If you choose to run licenses over a WAN, be aware of how your systems resolve
host names. Always use the fully qualified domain names in the SERVER line and
on the clients. This technique tends to reduce the number of issues with hostname
resolution.

support

Rational floating licenses can be used in a Novell 5.0 environment that is
configured with TCP/IP or IPX. The Rational licensing implementation does not
support using Novell Netware 5.0 or later directly with floating licenses.

Authorized user licenses with Novell 5.0 are supported.
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Installing the server software on a Windows server

This section describes how to use the Setup wizard to install the Rational License
Server software that enables you to flexibly install and manage license keys. You
do not need to have a license key to operate the Rational License Server software.

Downloading Rational License Server

If you do not have a CD with the version of Rational License Server software you
require, you can download the license server from the Rational Download and
Licensing Center: https://wwwl4.software.ibm.com/webapp/iwm/web/reg/
signup.do?source=rational. Registration is required.

Before you install the license server on a Windows server

The requirements for installing the Rational License Server software on a Windows
server is minimal:

* The license server runs on Windows operating systems (NT 4.0 or higher),
except Windows 9x and XP Home computers.

¢ The Windows server must have a C:\ drive.
* You must have Windows administrator privileges on the local computer.
¢ The default TCP/IP port number is 27000.

* There is no minimum processor, memory, or disk space.

Note: Make sure that you have a current backup of your Registry and system
directories before running the installation program.

Default installation path

The Setup wizard uses C:\Program Files\IBM Rational as the default installation
path. If your C:\ drive lacks sufficient free disk space, either specify another drive
or make space available on the default drive. A C:\ drive must exist on the license
server regardless of where you install the Rational License Server software.

Using the Rational Setup wizard

This section describes how to install the license server. If you would like to install
the license server from a release area or set up a silent installation, see the
instructions in the installation guide for your IBM Rational product. The Setup
wizard guides you through the software installation. Click Next to launch the
installation, and to advance through the following screens.

The installation wizard does not display an error summary. To verify that an
installation was successful or to understand why it failed, look in the log of
installation activities. The install.log file is in your TEMP directory (for example,
TEMP=C:\DOCUME™1\<username>\LOCALS~1\Temp or C:\temp\install.log). The
location of the directory depends on the system environment variable set on the
computer.

Note: Interrupting an installation that is in progress may leave your computer in
an indeterminate state. If you try to close the Setup wizard window while
the installation is in progress, you are asked to confirm that you want to exit

from the incomplete installation.

To install the license server from a CD image:
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. Log in as a user with administrator rights on the local computer on which you

want to install the product.

. Insert the product installation CD into the computer’s CD drive.

The Setup wizard starts automatically.
If autorun is disabled on your computer, click Start > Run and enter
cd_drive: \Setup.exe where drive is the letter of the CD drive.

. The Product Selection page lists all products available for installation. Select

the Rational License Server.

. The Deployment Method page displays the Enterprise Deployment and

Desktop Install from CD Image options. Select the Desktop Install from CD
Image option.

. Choose to accept or not to accept the Rational software license agreement in the

License Agreement page. To view the Open Source license agreement, select
the check box View Open Source Agreement.

* If you accept the license agreement, the installation wizard continues.

* If you do not accept the license agreement, exit the Setup wizard by clicking
Cancel and then Finish. When you exit from the wizard, the Setup wizard
makes no visible changes to your computer.

. The Destination Folder page specifies the directory where you want to install

the Rational License Server software. Click Change to modify the location.

Note: The installation wizard requires that all IBM Rational products be
installed in the same directory.

. Click Install on the Ready to Install the Program dialog to begin the

installation.

. A Restart Windows page opens if the Setup wizard needs to restart your

computer. If files required for the installation are in use during the Setup
program and if the program needs to install shared components on your
computer, the Setup wizard may need to restart your computer.

Select Restart or Don’t Restart. If you select Don’t Restart, the wizard reminds
you that the installation cannot complete until Windows restarts.

After Windows restarts, log on as the same user. If you do not, the installation
does not complete correctly. The second part of the installation process starts
automatically after you log on.

. When the Setup wizard Completed window opens, we recommend that you

select the Show me the readme file option to review the current information
related to features and known issues. In addition, you can select Take me to
IBM developerWorks®. Click Finish to complete the installation.

Note: Install the floating license keys on the license server before you start the
license server. See [“Using floating keys on a Windows license server” on|

Opening the License Key Administrator (LKAD)

24

The IBM Rational License Key Administrator (LKAD) is installed with many IBM
Rational products and with your Rational License Server software. This application

provides an interface to IBM Rational Common Licensing (powered by FLEXIm
software). Use the LKAD or the LKAD wizard to enter or import license keys and
change your license configuration.

IBM Rational : License Management Guide



Note: For IBM Rational products built on the Eclipse framework, use the IBM
Installation Manager to manage your license configuration on the desktop.
* To access the LKAD and the LKAD wizard on a desktop, click Start >
Programs > IBM Rational > Rational License Key Administrator.
e To access the LKAD and the LKAD wizard on the license server, click Start >

Programs > IBM Rational > Rational License Server > Rational License Key
Administrator.

Note: You must have administrative privileges on the computer before you can
enter or import license key information in the LKAD.

To access the Help, click Help in the License Key Administrator’s main menu, click
Help in the LKAD wizard, or open <Install Path>\1BM Rational\doc\help\
Ticadmin\index.htm.

Using floating keys on a Windows license server

This section describes how to import or enter floating license keys on the Rational
License Server software.

Importing floating license keys

Import the license key file on the license server by using the License Key
Administrator (LKAD).

Note: You must have local administrative privileges for the server before you can
import the license key into the LKAD.

To import a license key file in the LKAD:
1. Click License Keys > Import License Key(s).

2. In the Import License Key(s) window, find the *.upd or *.txt file (license key
file) and select it.

3. Click Open. The default location for the license key file is <Install Path>\1BM
Rational\Common.

4. Click Import in the Confirm Import window.

Other methods

* If your e-mail program supports launching programs from file attachments,
double-click the .upd or .txt attachment in the e-mail notification that you
received from License Key Center. Select Open it in the Opening Mail
Attachment window. Click Import in the Confirm Import window.

+ Save the file attachment to any folder and double-click the license file.
* Use the LKAD wizard.

Entering temporary floating license keys

You may enter a temporary or evaluation license key on the license server if you
are evaluating the product or License Key Center is unavailable.

Note: You must have local administrative privileges for the server before you can
enter the license key into the LKAD.

To enter license information in the LKAD:

1. Click License Keys > Enter a License in the License Key Administrator.
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2. Select the type of license.
3. In the next window, enter the following information:
* Product
* Expiration Date
* License Key
* Quantity (if you are installing a floating license key)

4. Click Finish. The License Key Administrator adds this information to the
license key *.dat file in <Install Path>\1BM Rational\Common.

Using named-user keys on a Windows license server

Named-user license keys perform as floating license keys, except that during the
import process, the License Key Administrator (LKAD) gives you the opportunity
to specify a user for each license key. You assign a user to a key by editing the
rational.opt file. The options file locks the floating license key to the user; allowing
the user to run Rational Purify, IBM Rational Quantify, or IBM Rational
PureCoverage on multiple desktops.

Importing named-user license keys

Import the license key file on the license server by using the License Key
Administrator (LKAD).

Note: You must have local administrative privileges for the server before you can
import the license key into the LKAD.

To import a license key file:
1. Click License Keys > Import License Key(s).

2. In the Import License Key(s) window, find the *.upd or *.txt file (license key
file) and select it.

3. Click Open. The default location for the license key file is <Install Path>\1BM
Rational\common.

4. Click Import in the Confirm Import window.

5. Edit the options file (rational.opt). The LKAD provides an options file in
which you can assign named-user license keys. As soon as you import the
license key file, the Edit Options File window opens. If you choose to edit the
file:

a. The options file automatically opens in a text editor. Follow the instructions
in the file for the correct syntax in assigning user ids to license keys.

b. After you edit the file, save it, and then close the file.

Note: You can edit the options file while the license server is running, but
stop and start the license server after you have edited the file.

Entering temporary named-user license keys

You may enter a temporary or evaluation license key on the license server if you
are evaluating the product or License Key Center is unavailable.

Note: You must have local administrative privileges for the server before you can
enter the license key into the LKAD.

To enter license information in the LKAD:
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1. Click License Keys > Enter a License in the License Key Administrator.
2. Select the type of license.
3. In the next window, enter the following information:

¢ Product

* Expiration Date

* License Key

* Quantity (if you are installing a floating license key)

4. Click Finish. The License Key Administrator adds this information to the
license key *.dat file in <Install Path>\1BM Rational\Common.

Starting the Windows license server

Start the Rational License Server software after you have imported or entered the
license keys. The license server will not start until license keys are installed. Use
the correct procedure based on the version of the Windows operating system on
your license server.

Note: Although the control panel applet may still be on your server from an
earlier release of the license server software, starting with version 2001, the
Rational License Server software does not use the FLEXIm control panel

applet.

Starting the license server on Windows XP

1. Click Start and select Settings > Control Panel > Administrative Tools >
Services > FLEXIm License Manager.

2. Click Start the service.

Starting the license server on Windows 2000

1. Click Start and select Settings > Control Panel > Administrative Tools >
Services > FLEXIm License Manager.

2. In the General tab, click the Start button under Service Status.

Starting the license server on Windows NT

1. Click Start and select Settings > Control Panel > Services.
2. Click the FLEXIm License Manager in the Services window and click Start.

Switching to manual startup

The Rational License Server software is automatically set as a Windows NT®
service. The default Startup type is automatic, which means that the license server
starts automatically each time you start the computer. If you prefer to manually
start the license server, switch the startup type.

Switching startup type on Windows XP

1. Click Start and select Settings > Control Panel > Administrative Tools >
Services > FLEXIm License Manager.

2. Right-click FLEXIm License Manager, and then click Properties.
3. In the Startup type window, on the General tab, select Manual.
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Switching startup type on Windows 2000

1. Click Start and select Settings > Control Panel > Administrative Tools >
Services > FLEXIm License Manager.

2. In the General tab, select manual under Startup type.

Switching startup type on Windows NT

1. Click Start and select Settings > Control Panel > Services > FLEXIm License
Manager.

2. In the window, select manual under Startup type.

Running the LKAD command line on Windows (optional)

28

To automate license configuration on client desktops, create a text file and batch
file that specifies single, multiple, and redundant license servers on client desktops.
Users enter commands in Windows to run the batch file and text file.

Note: These commands do not support authorized user license keys.

* If users are performing silent installations, add a post-installation section to the
site defaults file. The post-installation section launches batch file commands after
the installation finishes. The batch file directs the LKAD to use the server
information in the text file. To add a post-installation command to the site
defaults file, see |[“Specifying the post-Installation command and batch file” on|
For more information about silent installations, see the installation
guide for your IBM Rational product.

* If users are not performing silent installations, have them use the command line
to direct the LKAD to use information in the text file. To set up the text file and
run the LKAD from the command line, see [“Creating the text file that specifies|
[license servers” on page 29|

Specifying the post-Installation command and batch file

After you set up a site defaults file, append the following commands to the file.

1. Use a text editor such as Notepad to edit the site defaults file. Append a line
similar to the following example. The label [PostInstallCmd] is required:
[PostInstallCmd]
Command=post-installation-commands.bat

2. Save the site defaults file.

3. Use the same text editor to create the post-installation-commands.bat file. This

batch file directs the LKAD to use the license server information in the text file
(server-info.txt). This batch file might contain the following commands:

licadmin -fserver-info.txt

net send administrator "Installation Complete"

In this example, the client desktop’s License Key Administrator, licadmin, starts
and uses the information in server-info.txt to specify the name of the license
server that the client desktop will use. The batch file then sends a message to
the administrator, indicating that the installation is complete.

4. See[‘Creating the text file that specifies license servers” on page 29| for the
commands to insert in the text file server-info.txt.
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Creating the text file that specifies license servers

The following section provides instructions for setting up the text file that specifies
single, multiple, or redundant license servers. These instructions also provide the
commands for running the LKAD from a command window if users are not
running silent installations.

Specifying single or multiple license servers
To specify the name of single or multiple license servers in a client desktop’s
License Key Administrator:

1.

Create a file in a text editor, such as Notepad, that contains the following line:

PortAtHost:27000@Serverl

where Serverl is the name of the license server.

When you type this line:

* The keyword PortAtHost is case sensitive.

¢ The number 27000 is the default port number.

* Use semicolons in the series of server names. The trailing semicolon is
required.

To add an additional server, enter @Server2, where Server? is the name of the

additional license server.

PortAtHost:27000@Serverl ;@Server2;

Save the file, for example, server-info.txt.

In a command window (if the user is not running a silent installation), enter

the following command:

licadmin -fserver-info.txt

Your computer will be configured to use floating license keys from Serverl and

Server2.

The results of running this command are written to the status file
server-info.txt STATUS, where server-info.txt is the name of the license
parameter file you created. The status file is created in the directory where you
placed the server-info.txt file.

Specifying redundant license servers
To specify the names of redundant license servers in a desktop’s License Key
Administrator:

1.

Create a file in a text editor, such as Notepad, that contains the following line:
PortAtHost:27000@Redundant1,27000@Redundant2,270000Redundant3;

where Redundant1 is the name of the primary Rational License Server,
Redundant? is the name of the secondary license server, and Redundant3 is the
name of the tertiary license server. The number 27000 is the default port
number.

When you type this line:

* The license servers must be specified in the order of Primary, Secondary, and
Tertiary (Backup) server. For more information about redundant server order,
see [“Setting up redundant Windows license servers (optional)” on page 32}

* The keyword PortAtHost is case sensitive.

¢ Use commas in the series of redundant server names. The trailing semicolon
is also required.

* You can specify redundant servers and multiple servers in one file. Use
commas between redundant servers and semicolons between servers.
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PortAtHost:27000@Redundant1,270000Redundant2,270000Redundant3;
27001@Serverl ;@Server?2;

Or

PortAtHost:27001@Serverl;27000@Redundant1,27000@Redundant?,
270000Redundant3;@Server?2;

2. Save the file, for example, server-info.txt.

3. In a command window (if the user is not running a silent installation), enter
the following command:
licadmin -fserver-info.txt

The results of running this command are written to the status file
server-info.txt_STATUS, where server-info.txt is the name of the license
parameter file that you created. The status file is created in the directory where
you placed the server-info.txt file.

Specifying the license server on Windows Web servers

30

In the case of RequisiteWeb and Rational ClearQuest Web, the Web server is the
client of the license server. For example, when a user opens RequisiteWeb on a
client, the RequisiteWeb Requirements server, on behalf of the user, requests the
floating license from the license server.

Use the following procedures to specify the license server host name(s):
1. Open the License Key Administrator (LKAD):

* After the product installation is complete, launch the LKAD wizard and the
LKAD. The License Key Administrator main window and the License Key
Administrator wizard open.

* If you decided not to launch the LKAD wizard and LKAD immediately after
product installation, click Start > Programs > Rational <product name> >
Rational License Key Administrator. The License Key Administrator main
window and the License Key Administrator wizard open.

2. Select Settings > Client/Server Configuration.
3. Click Add Server.
4. Single should be the default value next to Server Type. Enter the host name of

the license server in the Values column next to Server Name by clicking
New-Server. After entering the host name, press Enter.

Additional Servers

If you have additional license servers, click Add Server and enter the host name
for each server.

Note: Do not use Add Server for a redundant server environment.

1. Click OK after you have entered all servers.

Your Web server requests licenses from servers in the order that you enter the
servers in the LKAD. If you want to change this order, see|"Changing the

lserver search order” on page 77}

Configuring Web servers to use redundant Windows servers

Redundant servers are a system of three servers that work as a team to manage a
single pool of floating license keys. If one of the servers goes down, the other two
license servers automatically continue managing the license pool.

To enter the redundant license servers on the Web server:
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Click Settings > Client/Server Configuration.
Click Add Server.
Click Single next to Server Type. Select Redundant in the menu.

Ao~

Enter the Primary, Secondary, and Tertiary license server host names in the
order in which the license administrator requested them in License Key Center.
Press Tab to move to the next line.

5. Click OK.

Difference between time-out period and linger time

The time-out period is the set period of product non-use after which the license
server will reclaim a license. The license server will reclaim a floating license when
the product has not been used for a default period of 120 minutes. If you use the
product again after the server has reclaimed its license, the product will check out
the license again from the server.

The linger time is an interval that is reset to the beginning each time a user runs a
command in the application. If the linger time expires before the user runs another
command, the user’s license is returned to the pool of available floating licenses,
and the user has to acquire another license to run any more commands. This linger
interval is set and cannot be changed.

ClearCase LT and floating license linger time

Unlike other IBM Rational products, ClearCase LT licenses operate with a linger
time of 30 minutes. The first time a user runs a ClearCase LT command that takes
a license, the license is allocated to that user for 30 minutes. This 30 minute
“linger” interval is re-started every time the user runs a ClearCase LT command
that takes a license. You cannot adjust this linger time.

If Rational ClearCase LT checks out a suite license, the suite license does not
operate with a 30 minute linger time. It operates with a time-out period instead.

Modifying the floating license time-out period

To change the time-out period, create a text file called rational.opt in the

<rational>\common directory. Enter one of the following two commands in the text

file:

1. TIMEOUT feature seconds directs the license server to reclaim the feature (the
product as it is listed in your license key file) after the number of seconds that
you enter into the file.

2. TIMEOUTALL seconds directs the license server to reclaim all products after
the number of seconds that you enter into the file.

The value for each of these options must be greater than 7200 seconds (or 120
minutes).

Note: ClearCase LT licenses do not have time-out periods. They operate with
linger times.
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Setting up redundant Windows license servers (optional)

Rational license servers can be set up to run in a fault-tolerant configuration
known as redundant servers. Redundant servers are a system of three servers that
work as a team to manage a single pool of floating license keys. If one of the
servers goes down, the other two license servers automatically continue managing
the license pool. If any two license servers no longer work, the third license server
will no longer serve licenses. Two servers must operate to serve licenses to clients.

Example

You have purchased 25 floating licenses of Enterprise Suite and wish to set up a
redundant server configuration on three Windows computers. You request
permanent keys for the redundant servers using License Key Center. You install the
Rational License Server software on each of the three redundant server partners;
servers A, B, and C. When you receive the license file of 25 permanent floating
keys, you install the license file on each server.

The three servers work as a team to manage all 25 floating licenses in unison.
When you have 20 license keys checked out to your users and server A crashes,
servers B and C continue to manage the 25 licenses.

Important: It is a common misconception that separating redundant servers across
multiple sites (for example, one in the U.S., one in Europe, and one in
Asia) provides maximum fault tolerance. This is not the case.
Redundant servers should always be at the same site and on the same
subnet.

To configure redundant license servers:

1. Install Rational License Server software on three computers. See |”Working witEl
a supported network configuration” on page 22| and |“Installing the server|
software on a Windows server” on page 23|

Note: Use a redundant environment of either all Windows servers or all UNIX
servers.

2. Import a license file that you receive from IBM on each license server. See
[“Using floating keys on a Windows license server” on page 25| for more
information.

3. Start the license servers. The sequence is not important, but you should start
the servers soon after one another. See [“Starting the Windows license server”]
for instructions.

4. Give client desktop users the Primary, Secondary, and Tertiary (Backup) license
server host names in the order in which you requested them in License Key
Center. They need to enter the host names in their LKADs.

License monitoring (optional)

You may need to monitor and report license usage. Macrovision offers a solution
for license usage reporting called SAMreport. SAMreport is designed specifically
for reporting on license server activity. SAMreport offers a full set of administrative
tools that generates reports, graphs, high-water marks, and even sets alarms to
notify individuals when a server has gone down or the license pool is nearly
exhausted. SAMreport works with any vendor’s FLEXIm server. It is available only
through Macrovision: http://www.globes.com/support/samsolutions_index.htm.

32 IBM Rational : License Management Guide



If you do not need extensive license usage reporting, use the Imtools GUI to find
out who used which license and when the user did so. If the license server is
installed, click Start > Programs > Rational FLEXIm License Server > License
Tools. License Tools starts the Imtools GUI.

1. Select Configuration using Services in the Mode menu.

2. Click the Server Status tab and the Perform Status Enquiry in the Server
Status window.

Using floating licenses with a firewall

The Rational licensing implementation supports a firewall. To configure licensing
with a firewall, give the Imgrd daemon (license manager) and the vendor daemon
(Rational vendor, rational.exe or ibmratl.exe) TCP/IP port numbers. The TCP/IP
port is used for client/server communication for floating licenses.

In a non-firewall situation, the Imgrd daemon starts on TCP/IP port 27000 when
you start the server. (You will have to change this number if another application is
using this port number.) The Imgrd daemon assigns a random TCP/IP port
number to the vendor daemon.

In a firewall situation, the client cannot communicate with the daemons on the
license server because the ports on which they are running are blocked. To enable
license requests to pass through the firewall, assign numbers to the vendor and
Imgrd ports. The vendor daemon and Imgrd daemon must start on a specific port
number each time a client makes a license request and checks out a floating license
from the server. The specified ports or connections remain open until the client
returns the license to the server.

Note: The vendor daemon and the Imgrd daemon cannot be set to the same port
number.

In a sample firewall situation, a Rational product can communicate with the Imgrd
daemon and rational.exe or ibmratl.exe (vendor daemon) on the license server
through a firewall if the numbers 27000 and 8000 have been assigned to the ports.

When you specify the port information, the License Key Administrator stores the
port information in the registry.

Use the following procedures to change the Imgrd and vendor ports in single,
multiple server, or redundant server environments. They assume that you have
already started the license servers and entered the host names of the license
servers in each client.

Assigning port numbers in the license server

To enable clients to communicate with the license server, enter values in the Imgrd
port and the rational vendor port.

To enter port numbers on a license server or redundant license servers:
1. Select Settings > Server Ports in the License Key Administrator.

2. In the Server Ports window, enter values in the Imgrd port and the rational
vendor port, but do not set them to the same value.

3. Click OK.
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4. If the server is a redundant server, enter the same port value on each of the
redundant servers by repeating Steps 1-3. If there are multiple license servers,
enter the same port value on each license server by repeating Steps 1-3.

5. Give users the rational vendor port value to enter into their client desktops.

Changing the Imgrd port

When another application is using the TCP/IP port 27000 that is used by Imgrd
(license manager daemon), change the Imgrd port. You do not need to enter a
value in the rational vendor because it runs on a random TCP/IP port.

Use the following procedures to change the Imgrd port in single, multiple, or
redundant server environments. They assume that you have already started the
license servers and entered the hostnames of the license servers in the
configuration utility of each desktop.

To change the Imgrd port value on a license server or redundant server:
1. Select Settings > Server Ports in the License Key Administrator.

2. In the Server Ports window, enter a value in the Imgrd port.

3. Click OK.
4

. If the server is a redundant server, enter the same Imgrd port value on each of
the other license servers by repeating Steps 1-3.

Removing the Rational License Server software for Windows

34

This section describes how to remove the Rational License Server software from
the server.

Before you remove the Rational License Server software

1. Make sure that no one is using the license server or any associated files. You
cannot remove files that are in use.

2. Return the license keys to your account through License Key Center. For more
information about moving or returning licenses, see [Chapter 5, “Returning or
[moving keys for administrators,” on page 49}

3. To remove the software from a Windows computer, you must have Windows
administrator privileges on the local computer.

Removing the Rational License Server software

Use the Windows Add/Remove Programs control panel to select and remove the
Rational License Server software. The Rational installation program removes the
files from your computer. It does not remove directories that contain files that you
created while you were using the software. It also does not remove the license key
files from the server.

IBM Rational : License Management Guide



Chapter 4. Configuring a UNIX license server

With floating and named-user floating keys you can manage and maintain licenses
on single, multiple, or redundant Rational license servers on Linux and UNIX
systems.

Note: For Rational Software Desktop Platform version 7.0 products built on the
Eclipse framework, the enablement of Rational Common Licensing and
floating licenses on desktops is an optional feature allowing administrators
to easily manage and enforce licensing across the enterprise.

This chapter describes how to set up and run UNIX license servers. The
information in this chapter is intended for system administrators or users who
manage licenses. If you want to use a Windows license server, see |Chapter 3,|
[‘Configuring a license server for Windows systems,” on page 19|

Some of the tasks in this chapter are not recommended for the casual or novice
user. Attempt them only if you have experience with the UNIX operating system
and IBM Rational Common Licensing (powered by FLEXIm software). You can
apply the UNIX commands to all UNIX operating systems unless the text indicates
the command is for a specific UNIX operating system.

Note: Rational Common Licensing (powered by FLEXIm software) support for
version 7.0 Rational Software Development Platform products built on the
Eclipse platform is enabled in a new release of Rational License Server
software. The new version of Rational License Server software serves both
previous Rational Common Licensing enabled Team products (Rational
ClearCase, Rational ClearQuest, etc.) as well as the new Rational 7.0
products. If you need to serve both the Rational 7.0 desktop products and
the 7.0 Team products, you must upgrade to this latest version of the license
server. Two separate servers are not required since this new version of the
server supports the previous clients as well as the new Rational 7.0 clients.

Windows clients using a UNIX license server

See the relevant Rational point-product for UNIX installation manual for
information about configuring a UNIX license server.

If you do not have access to a Rational software installation manual, use the

procedures in this chapter to set up a UNIX license server. This chapter does not
provide instructions for configuring UNIX clients to access the UNIX license server.
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Setting up floating and named-user keys on a UNIX server

The general steps required to set up floating or named-user floating licenses on a
UNIX license server are described in The table provides a checklist of tasks
and references to more detailed instructions.

Table 8. Guide to setting up floating licenses on a UNIX server

Task Procedure

Set up floating licenses. * Understand IBM Rational Common Licensing.
See |Chapter 1, “Before requesting license keys,”|

|on page 3[

* Access License Key Center to order permanent
license keys for the products on your Windows
clients. See [Chapter 2, “Requesting license]
[keys,” on page 13|for more information about
License Key Center.

¢ Make sure that your license server and clients
are connected. See |“Before you install the]
[license server” on page 37}

 Install the license server software and license
keys on the UNIX license server. See |"Installing_§|
the license server and license on a UNIX]|
server” on page 37]

¢ Tell users to specify the Rational license server
in their Windows client desktops. See

Chapter 10, “Configuring clients to use floating|
keys,” on page 75

Set up named—user ﬂoating licgnses ¢ Understand the IBM Rational Common
(only applies to Purify, Quantify, and Licensing. See [Chapter 1, “Before requesting]
PureCoverage). [license keys,” on page 3|

¢ Access License Key Center to order permanent
license keys for the products on your Windows
clients. See [Chapter 2, “Requesting license|
[keys,” on page 13|for more information about
License Key Center.

¢ Make sure your license server and clients are
connected. See [“Before you install the license|
[server” on page 37}

* Install the Rational license server software and
license keys on the UNIX server. See |”Installin§|
the server and named-user keys on a UNIX|
server” on page 40|

* The License_Setup script asks you for user ids
to assign to the license keys.

¢ Tell users to specify the license servers in their
Windows client desktops. See thapter 10]
“Configuring clients to use floating keys,” on|

[page 75I

Configure redundant license servers. See [“Setting up redundant UNIX servers|
|(optional)” on page 40}
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Table 8. Guide to setting up floating licenses on a UNIX server (continued)

Task

Procedure

Change the order in which IBM
Rational products use licenses.

The license server does not set license usage
order. Use the client desktop to change the order.
For Team Unifying Products, see thapter 11,|
[’Changing license usage order,” on page 81[in

Part 2 and for Software Development Products,
see [Chapter 16, “Changing license usage order,”|

Ign page 101| in Part 3.

Using license keys for home use or
travel.

Disconnected use from UNIX license servers is
not supported. See [“Using license keys for home|
[use or travel” on page 11[for other options.

Modify the time-out period.

See [“Modifying the floating license time-out|
[period” on page 47}

Monitoring license server activity.

See [“License monitoring (optional)” on page 47

Upgrading the license server software.

You can upgrade the Rational license server
software to the most current version, but do not
run different versions of Rational license server
software on the same computer.

Running multiple license servers on
the same computer.

Run a separate Imgrd instance for each vendor
daemon and keep license keys in separate files.
Most vendors have an expected location for the
license file. If your company has license files from
multiple vendors, you can keep the data in
separate files and set the LM_LICENSE_FILE
environment variable to reference these multiple
files.

Remove the license server software.

See ["Removing the UNIX license server software”|

|9n page 42]

Installing the license server and license on a UNIX server

Installing the license server software on a UNIX computer includes installing or
entering the license keys. You should have your license key file when you install
the IBM Rational license server. Go to License Key Center to order your permanent

license keys. See [Chapter 2, “Requesting license keys,” on page 13| for more

information about License Key Center.

Before you install the license server

To set up the license server on a UNIX or Linux system, you need the Rational
license_setup script and licensing executables from the IBM Rational Download
and Licensing Center: https://wwwl4.software.ibm.com/webapp/iwm/web/reg/
signup.do?source=rational. Registration is required.

The requirements are minimal:

* The license server can be installed on all the UNIX platforms that Rational
supports. Rational does not support SunOs 4.x and IRIX 5.x.

* There is no minimum processor, memory, or disk space.

* The license server software must be installed locally (NFS is not supported). The
server runs a FLEXIm Imgrd process and a vendor daemon process to manage
licenses. For more information about these processes, see |Chapter 6,|

[“Understanding IBM Rational Common Licensing components,” on page 51}
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To check the connection between the server and clients, use the following UNIX
commands: ping, arp, rsh, rlogin, or telnet.

The License Key Center sends the license file to an e-mail account when you
request a license. It has the filename format similar to Ticense_for_server.upd.
You need to have either the license file (filename.upd) stored in a known
location, such as the $HOME directory, on the license server.

Installing the server software and floating license keys

38

Perform the following steps to install the license server and floating license key file
on a Linux or UNIX computer.

1.

Download the Rational License Server from the IBM Rational Download and
Licensing Center: https://wwwl4.software.ibm.com/webapp/iwm/web/reg/
signup.do?source=rational.

The download contains a tar.gz file, the name of which depends on the
intended platform. The name is of the form PARTNUM.tar.gz. For example,
C85WSEJA . tar.gz.

Important: Be sure to download the appropriate version for the platform on
which you are installing.

Unpack the files using gzip or gtar as shown in the following example.
Example using the C85WSJA tar file:
gzip —dc C85W8JA.tar.gz | tar —xf —

This will create a directory called RationalLicenseServer.7.0.0.1. PLATFORM,
where PLATFORM is one of AIX, Linux, Solaris, or HP-UX.

If you have GNU tar (gtar), it has the option to uncompress the file (-z) as it
untars the file. For example:

gtar —xzf C85W8JA.tar.gz

Run the license_setup script in the directory created by the uncompress/tar
command. The directory will not have the suffix: .tar.* For example:

cd RationallicenseServer.7.0.0.1.Linux
./1license_setup
The script starts by providing instructions for using license_setup.

The script prompts you for a Rational directory, such as rational_dir/config
directory.

Choose to accept or not accept the Rational license agreement.
 If you accept the license agreement, the script continues.

* If you do not accept the license agreement, you cannot continue with the
script. Exit the program. The script exits and makes no changes to the server.

Choose your license option from the Licensing Options Menu. Options are
summarized in the following table.

Option Description

1 You must choose this option whether you have a permanent
license key or a Fixed Term License. This option upgrades the
license server software (FLEXnet 10.x) and allows you to import
the license.upd file you receive.

Note: The license_setup script prompts you to provide the
location of the license file or gives you the option to
enter the license key information manually. If you do not
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have a license file containing your license keys, see
[Chapter 2, “Requesting license keys,” on page 13|

If you are using a permanent license, go to Step

2 Do not use option 2. Licenses will not be issued using this
option.

6. Provide your license file information by doing one of the following:

¢ Import the information from the license file automatically by giving the path
to the .upd file.

* Enter none to provide the license key information manually. You will need a
printout of the content of the .upd file. Follow the prompts to enter the
information.

Note: Do not enter the information manually because the data is case-sensitive
and very literal.

7. Define the location for the <server-name>.dat file that will be created from the
information supplied by the license_for_server.upd file. By default,
license_setup creates the <server-name>.dat file and stores it in the
rational_dir/config directory.

Choose either the default path (option 1, rational_dir/config directory) that
license_setup has selected or choose option 2 to specify an alternate path.

8. Proceed with the License Check menu.

Perform options 1-3 sequentially and continue to the next menu. If you are setting
up a permanent authorized user license, perform option 1 only. Note that these
options are the default settings provided by license_setup.

Restarting the UNIX license server when it reboots

After the license file is in place and the license daemons are running, the license
server needs to be set up to automatically restart when it reboots. The
license_setup script cannot do this automatically for you unless you ran the script
as root (root permissions). If you are not running the script as root, the script
directs you to become root and copy a file. The script directs you to the correct
location based on the operating system that you are using for placing the start-up
files.

The following sections provide the start script commands for these operating
systems:

o AIX
e HP-UX
e Linux

e Solaris

IBM AIX

% su
# Edit /etc/inittab. Add this line:

Imgr:234:once:/bin/sh rational_dir/config/start_lmgrd_on_server-name
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HP-UX

Linux

% su
# cp rational_dir/config/start_Imgrd_on_server-name \
/sbin/init.d/S98Rational

# In -s /sbin/init.d/S98Rational/sbin/rc2.d/S98Rational

% su

# cp rational_dir/config/start_Imgrd_on_server-name \
/etc/rc.d/init.d/S98Rational

# In -s /etc/rc.d/init.d/S98Rational /sbin/rc.d/rc3.d/S98Rational
# In -s /etc/rc.d/init.d/S98Rational /sbin/rc.d/rc4.d/S98Rational

# In -s /etc/rc.d/init.d/S98Rational /sbin/rc.d/rc5.d/S98Rational

Sun Solaris

$ su
# cp rational_dir/config/start_Imgrd_on_server-name \

letc/rc2.d/S98Rational

Installing the server and named-user keys on a UNIX server

Named-user license keys behave like floating license keys except that you are able
to specify a user for each license key. You assign a user to a key by creating a
rational.opt file. The options file locks the floating license key to the user; so that
the user can run Rational Purify, Quantify, or PureCoverage on multiple systems.

Follow the procedures explained in [“Installing the server software and floating]
[license keys” on page 38| The only difference that you will see is the script will
prompt you for user names and create the rational.opt file for you.

Setting up redundant UNIX servers (optional)

40

Redundant servers are a system of three servers that work as a team to manage a
single pool of floating license keys. If one of the servers goes down, the other two
license servers automatically continue managing the license pool. This type of
redundant configuration requires that a minimum of two license servers running at
all times. If two servers go down, licenses will be unavailable until one of the
servers is restarted.

Example

You have purchased 25 floating licenses of Enterprise Suite and want to set up a
redundant server configuration on three UNIX computers. You request permanent
keys for the redundant servers using License Key Center. You install the Rational
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license server software on each of the three redundant server partners; servers A,
B, and C. When you receive the license file of 25 permanent floating keys, you
install the license file on each server.

The three servers work as a team to manage all 25 floating licenses in unison.
When you have 20 license keys checked out to your users and server A crashes,
servers B and C continue to manage the 25 licenses.

Important: It is a common misconception that separating redundant servers across
multiple sites (for example, one in the U.S., one in Europe, one in Asia)
provides maximum fault tolerance. This is not the case. Redundant
servers should always be at the same site and on the same subnet.

It is a good practice to have a homogeneous redundant server setup is (that is, all
servers are running the same operating system); however, heterogeneous
environments are supported. For example, you could have two license servers
running Solaris and one running HP-UX.

Before you install the license server on redundant UNIX servers

To set up the license server software on redundant UNIX servers, you need the
licensing executables from the Rational download site and a license key file for
redundant UNIX servers from the License Key Center. Then configure a start script
and start each server.

The license_setup script cannot import license key files for redundant servers, and
it cannot start redundant servers. Instead, you must manually install the license file
and server software on each computer.

Here are the requirements for setting up redundant servers:

* If you have already set up a license server and want to use that server in the
redundant server configuration, remove the Rational License Server software
from the computer. See ['Removing the UNIX license server software” on page|

1. Return the license keys to the License Key Center (“Moving or removing]
[license keys on a UNIX server” on page 47).

2. Follow the instructions in this section for installing the license server and
license keys in a redundant server configuration.

* Request the license key file for redundant UNIX servers. Go to the License Key
Center and request a license for redundant servers. The License Key Center will
ask you for the primary, secondary and backup servers. Be sure to specify the
redundant servers in the correct order:

— Host ID is the primary server
— Host Name 2 is the secondary server
— Host Name 3 is the backup server
If you have problems receiving or working with the redundant server license file,

see [“Contacting IBM Customer Support for Rational software products” on page x|
Technical support will create a new license file for you.

Note: If you do not have an internet connection, see [“Requesting license keys|
without an internet connection or License Key Center availability” on page]

[E
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The license server can be installed on all of the UNIX platforms that Rational
supports. Rational does not support SunOs 4.x and IRIX 5.x.

There is no minimum processor, memory, or disk space.

License Key Center sends the license file to an e-mail account when you request
a license. It has the file name format similar to license_for_server.upd.

To check the connection between the servers and clients, use the following UNIX
commands: ping, arp, rsh, rlogin, or telnet.

The servers should be on the same subnet.

The license server software must be installed locally (NFS is not supported).
Each server runs a FLEXIm Imgrd process and a rational daemon process to

manage licenses. For more information about these processes, see [Chapter 6
[“Understanding IBM Rational Common Licensing components,” on page 51}

You must manually install the license server software on the servers.

Installing the server software and keys on redundant UNIX
servers

Because the license_setup script cannot import a redundant license key file, install
the license server software and license key file manually on each of the three
servers.

. Place a copy of the license file that you receive from License Key Center on

each of the three license servers and ensure that the order of the SERVER lines
is the same in each file.

a. You can verify the order of the SERVER lines by opening the license file and
checking for three server lines.

 If you do not have a three-server license file, return your license file to
License Key Center (Return transaction) and request a new license file for
redundant UNIX servers. If you have problems receiving, returning, or
working with the redundant server license file, see [‘Contacting IBM|
[Customer Support for Rational software products” on page x} Technical
support will make the correct changes to your account and create a new
license key file for you.

¢ If the SERVER lines are not in the correct order, you can edit the file to
change the order, change the server name (not the host ID), and change
the port number. You cannot add or delete server lines.

b. The license file (Ticense_for_primary.upd) needs to be copied to the
rational_dir/config directory. You need to maintain this file on all three
servers. Copy and rename the file to rational.dat as shown in the
following example:

cp license_for_primary.upd rational_dir/config/rational.dat

c. Assign a TCP/IP port to each server. You must assign a TCP/IP port
number to each server by modifying the port assignment in each SERVER
line.

Important: Redundant servers cannot communicate with each other if you
use the default port numbers: 27000 to 27009. Use a port
number between 1501 and 26999. Ensure that the port number
you use is not in conflict with any other TCP/IP services. Note
that the same port number can be used for each server, or the
port numbers can be unique.

Check that the port is not already in use. (Port 1706 is used in the following
sample commands.)

IBM Rational : License Management Guide



Check the etc/services file

grep “[ 11706/” /etc/services

Check the NIS services by using the ypcat services command.
ypcat services | grep “[ 11706/

Note: There is a tab and a space character between the [ ].
Edit the license file to use the new port numbers.

cd rational_dir/config

vi rational.dat

Your license file should look similar to the following example.
SERVER primary 8001d410 1706

SERVER secondary 8001d625 1706

SERVER backup 8001d873 1706

2. Locate the FLEXIm utilities in the RationalLicenseServer package. The files are
in one of the extras/flexIm.* directories. The directory name depends on the
FLEXIm version and platform. Example: extras/flexlm.10.8.0.1.i386_linux2.

3. Copy the FLEXIm files to the rational_dir/config directory on all three
servers. The term rational_dir/config is used herein to represent the location
from which you plan to run the license server software.

Note: Be sure to copy the appropriate tar file for the platform on which you are
installing.

Configuring and starting the redundant UNIX license servers

Do the following to start the redundant servers:

 Configure the start script for each server. This is best done by copying a
template file from the Rational License Server download site and modifying it.
The download address is provided in the following section.

* Start each license server manually by using the start_lmgrd script.

Configuring the start script

Working from the rational_dir/config directory, create a start script for each
server.

1. Obtain a template start script at the IBM Rational Download and Licensing
Center: https://wwwl4.software.ibm.com/webapp/iwm/web/reg/
signup.do?source=rational.

2. Copy the start_Imgrd template file to the config directory:
cp start _Imgrd template rational dir/config/start Tmgrd.

3. Change these 4 lines to match your installation. The template assumes
rational_dir is /opt/rational, the license file is license.dat, and joe is the user id
that will own the Imgrd/rational process when it runs as root during system
start.

LICENSE_DIR=/opt/rational/config
LICENSE_DAT=$LICENSE_DIR/1license.dat
LICENSE_LOG=$LICENSE_DIR/Ticense.log
LICENSE_EXE=$LICENSE_DIR/1mgrd
LICENSE_USER=joe
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Solaris Example:
FLEXROOT=/usr/rational/flexIm.7.0f
LICENSE_DIR=rational_dir/config/sun4_solaris2
LICENSE_DAT=rational_dir/config/rational.dat
LICENSE_USER=joe

HP-UX Example:
FLEXROOT=/usr/rational/flexIm.7.0f
LICENSE_DIR=rational_dir/config/hppa_hpux
LICENSE_DAT=rational_dir/config/rational.dat
LICENSE_USER=joe

The preceding examples show the license server being installed in the same
location, using the same license file name, and the same user. This helps simplify
the setup and makes it easier to maintain.

Starting redundant UNIX license servers

The servers must be started in the correct order: primary, secondary, and backup.

1. At the rational_dir/config directory where you copied the template start
script (start_lmgrd), enter the following command:

Jstart_Ilmgrd
2. Repeat Step 1 for the secondary and backup servers.
3. Check the status of each server:

Jstart_lmgrd Imstat -a

You should see the three servers listed as running and a list of the license keys
being served.

To stop the license servers:
Stop each license server by entering the following command:

Jstart_lmgrd stop

To verify the license file:
Check the Rational INCREMENT lines by running the exinstal command:

Jstart_Ilmgrd ex

This command generates a report on all of the increment lines and identifies if
they are properly encrypted.

Problems starting the redundant UNIX license servers

If the license server will not start, check the corresponding Imgrd log file (specified
by LICENSE_LOG in start_Imgrd).

1. Error message: ulimit: bad ulimit

If you see this message when you run start_lmgrd, remove the ulimit
command from the script.

2. If there are any other problems, check that the start scripts reference the correct
license file (LICENSE_DAT), the license directory (LICENSE_DIR), and the
license log file (LICENSE_LOG). Mail the start scripts, the license files, and the
log files to technical support. For more information about contacting Rational
licensing support sed”Contacting IBM Customer Support for Rational software|
[products” on page x|
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Restarting the redundant UNIX servers when they reboot

All three license servers should be set up to be restarted at boot time. To set this
up, copy the start script to the appropriate system directory.

Note: For security reasons, do not run Imgrd as root. Run Imgrd as a user by
setting the LICENSE_USER variable. The user ID that you specify must exist
on the system that runs the start script. In the following example, the user is
set to “joe”.

LICENSE_USER=joe

In previous releases, Rational used the filename STmRational.sh in the system start
directories. If there is an STmRational.sh file under any of the /etc/ or /sbin
directories, remove and replace it with S98Rational. The following sections provide

the start script commands for each operating system.

Note: You must be root to perform these steps.

Sun Solaris
cd /usr/rational/flexlm

cp start_lmgrd /etc/rc2.d/S98Rational

If you need to remove a reference to the SImRational.sh file, use the following
command:

/bin/rm -f /etc/rc2.d/SImRational.sh

HP-UX

cd /usr/rational/flexIm
cp start_lmgrd /sbin/init.d/S98Rational
In -s /sbin/init.d/S98Rational /sbin/rc2.d/S98Rational

If you need to remove a reference to the SiImRational.sh file, use the following
command:

/bin/rm -f /sbin/*.d/SImRational.sh

IBM AIX®
Edit /etc/inittab and add a line to run the start script using /bin/sh:

Imgr:234:once:/bin/sh/usr/rational/flexIm/start_Imgrd

Linux
cd /usr/rational/flexIm

cp start_lmgrd /etc/rc.d/init.d/S98Rational
In -s /etc/rc.d/init.d/S98Rational /etc/rc.d/rc3.d/S98Rational
In -s /etc/rc.d/init.d/S98Rational /etc/rc.d/rc4.d/S98Rational

In -s /etc/rc.d/init.d/S98Rational /etc/rc.d/rc5.d/S98Rational
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License manager commands
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IBM Rational Common Licensing uses the License Manager, version 10.x, from
Macrovision Corporation. The License Manager includes the following
components:

* A vendor daemon named rational or ibmratl that dispenses Rational licenses.
The rational daemon is used for most Rational licensed products. The ibmratl
daemon is used for licensed IBM Rational products built on the Eclipse
framework. If you have other products from other vendors that also use FLEXIm
software, they will include their own vendor daemons.

* A license daemon named Imgrd. The Imgrd daemon does not process requests
on its own, but forwards requests to the appropriate vendor daemon.

* A license file that you maintain. The license file specifies your license servers,
vendor daemons, and product licenses.

Note: Use a single combined license file for all Rational products.

To verify that your license manager is operational, you can enter these commands
on your UNIX license server to see if its daemons are running:

% ps axw | grep -v grep | egrep “Imgrd | <vendor>"
Where <vendor> is rational or ibmratl.

or

% ps -e | grep -v grep | egrep “Imgrd | <vendor>"
Where <vendor> is rational or ibmratl.

The output should include lines similar to the following (your path names may
vary):

538 ?? S 0:03.50 /rational/base/cots/flexlm.7.0f/platform/Imgrd
-c /rational/config/servername.dat

-1 /rational/config/servername.log

539 ?? I 0:00.90 rational -T brazil 6.0 3 -c ...

The following table summarizes the system-administration commands that the
license manager provides.

Command Description

Imdiag Enables you to diagnose problems when you cannot checkout a
license.

Imdown Shuts down license and vendor daemons.

Imhostid Reports license manager host ID of workstation.

Imremove Returns specific licenses to license pool on license server (for
example, after a system crashes.

Imreread Rereads license file, starts new vendor daemons.

Imstat Reports status on daemons and feature usage.
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exinstal Reports on rational licenses in license file that you specify on the
command line. The exinstal and exinstr] commands check the
license file format and license codes to see if everything is
consistent.

exinstrl Reports on ibmratl licenses in license file that you specify on the
command line. The exinstal and exinstr] commands checks the
license file format and license codes to see if everything is
consistent.

Additional licensing commands

In addition to using the commands in the previous list, you can also use the
license_check command to run the FLEXIm Imstat command for counted licenses
and the exinstal command for any license file (not port@host). The Imstat
command queries the license server for a list of licenses that are in the license pool.
The exinstal command checks the license file format and license codes to see if
everything is consistent.

Moving or removing license keys on a UNIX server

Use the instructions in [Chapter 5, “Returning or moving keys for administrators,”|
to return or move license keys on the UNIX server. To remove the
license server from a UNIX server, see [‘Removing the UNIX license server|
lsoftware” on page 47

Modifying the floating license time-out period

See the ["Modifying the floating license time-out period” on page 47 for
information about the time-out period and how to change it.

License monitoring (optional)

You may need to monitor and report license usage. Macrovision offers a solution
for license usage reporting called SAMreport. SAMreport is designed specifically
for reporting on license server activity. SAMreport offers a full set of administrative
tools that generates reports, graphs, high-water marks, and even sets alarms to
notify individuals when a server has gone down or the license pool is nearly
exhausted. SAMreport works with any vendor’s FLEXIm server. It is available only
through Macrovision. Detailed information on SAMreport can be found at:
http://www.globes.com/support/samsolutions_index.htm.

In addition to SAMreport, there is a new product called FLEXnet Manager.
Customers can read about this license monitoring tool at: http://macrovision.com/
products/flexnet_manager/

Removing the UNIX license server software

This section describes how to remove the license server software from the
computer.

Before you remove the license server software

Return the license keys to your Rational account through License Key Center, the
online license management tool. For more information about moving or returning
licenses, see [“Moving or removing license keys on a UNIX server” on page 47}
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Removing the license server software

To remove the license server from the UNIX server.

1. Go to rational_dir/config or /usr/rational/flexIm.7.0f

2. Shut down the server with one of the following commands:
Imdown -c <license_file>

Example:
Imdown -c rational.dat

or
Imdown -c <port@host>

Example:
Imdown -c 27000@hershey

or
ps -e | grep Imgrd #

To find the pid of Imgrd:
kill <pid> #

Where <pid> is the process ID of Imgrd

Note: If you use kill -9 <pid>#, the server might leave a Tockrational or
Tockibmrat1 file in either /tmp or /usr/tmp. You need to remove this file.

1. To remove the license server software, go to the <rational_dir> directory at
rational_dir/config and delete the IBM Rational FLEXIm directory:

cd <rational-dir> /config or /usr/rational/config/flexIm.7.0
rm -fr rational-dir/config/flexlm.7.0f

To remove just the Solaris software:
rm -fr base/cots/flexIm.7.0f/sun4_solaris2

To remove just the HP-UX software:
rm -fr base/cots/flexIm.7.0f/hppa_hpux

IBM Rational : License Management Guide



Chapter 5. Returning or moving keys for administrators

If you need to upgrade your license keys, replace an old license server, or move
the license keys to another computer, you must perform a floating or authorized
user license key return transaction in License Key Center. Because permanent
authorized user and floating license keys are tied to a computer’s host ID, IBM
Rational products will not work on another computer until you register the
products to the new computer.

Returning or removing permanent license keys

Use License Key Center to return authorized user, floating, named-user floating,
and redundant server license keys to your Rational account.

Note: For IBM Rational products built on the Eclipse framework, permanent
authorized user license keys from the activation kit are not managed by the
Rational License Key Center and cannot be returned.

When you return a license key, you do not physically give the license key back to
Rational. Instead, you use the Return transaction in License Key Center. The
License Key Center transaction updates records to indicate that you are no longer
using an IBM Rational product on that computer. This adjusts the count of
registered products in your account.

After License Key Center makes the adjustments to your account, License Key
Center sends you a license key file that contains updated license key information
even if you have returned all the license keys for that computer. To comply with
your License Agreement, import this updated license file (whether the file is empty
or not) on the computer.

Note: If you have problems returning or requesting a new redundant server
license file, Technical support will make the correct changes to your account
and create a new license file for you.

To return a license key:
1. Perform the return transaction in License Key Center.

2. When you receive the update file from License Key Center, import the file on
the old desktop or license server.

3. Remove the IBM Rational software or license server software from the old
desktop or license server. See the installation guide for your IBM Rational
product for the removal procedures.

Moving permanent license keys

If you want to move IBM Rational software to another desktop or server, return
the existing license keys from the old desktop or server to your account. Then
request license keys for the new desktop or server.

Note: If you have problems returning or requesting a new redundant server
license file, see [“Contacting IBM Customer Support for Rational software]
[products” on page x| Technical support will make the correct changes to
your account and create a new license file for you.
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To move license keys from one computer to another:

1.

Use License Key Center to return the license keys to your Rational account. See
[‘Returning or removing permanent license keys” on page 49|

Note: To help prevent you from confusing the license key update file for the
old computer with the license key file for the new computer, you may
want to complete the return transaction before you order license keys for
the new computer.

Request new license keys for the new computer in License Key Center.

Remove the IBM Rational software or license server software from the old
computer. See the installation guide for your IBM Rational product for the
removal procedures.

Install the IBM Rational software or license server software on the new
computer.

Import the new license key file on the new computer.

If you moved the license keys to a new license server, give client desktop users
the host name of the new license server.
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Chapter 6. Understanding IBM Rational Common Licensing
components

This chapter describes how FLEXIm software features and options have been
implemented in IBM Rational Common Licensing.

Locating the licensing components

IBM Rational files and license key files are installed in <Install
Path>\Rational\Common\ unless otherwise noted.

Understanding the license server process

Licenses are managed by a license manager that runs on a license server. The
license manager monitors license access, simultaneous usage, idle time, and so on.
When you start any IBM Rational product, you are initially unlicensed. If a license
for that product is available, the license manager gives you a license. You retain the
license while you are using the product. When you exit the application, your
license is returned to the license manager and is made available for another user. If
a license is unavailable, you are unable to use the product until a license is
returned by another user.

The following sections provide detailed information about the Rational license
server and license file, including descriptions of the license daemons running on
the server.

License components

The Rational license configuration includes these major components, which are
described in the following sections:

* License key file
* License manager daemon (Imgrd)
* Vendor daemon

License key file

License key definitions are stored in a text file called the license key file. The
license key file is created based on the data that you provided in License Key
Center. The license file can contain license key data for several products and is
created for a specific host. The License Key Administrator installs the license key
file.

The license key definition contains information about the server nodes and vendor
daemons, and at least one line of data (called FEATURE or INCREMENT lines) for
each licensed product. Each FEATURE line contains a license key based on the
data in that line, the host ids specified in the SERVER lines, and other
vendor-specific data.

When users start an IBM Rational product, the environment variable

LM_LICENSE_FILE is automatically defined for them. License manager uses this
variable to locate the license file.
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License file names
describes the types of license key files.

Table 9. License key files

File Name Description Notes

rational_temp.dat Contains all authorized Obtain a permanent license
user temporary license key to continue to use your
keys. IBM Rational product past the

temporary key expiration date.

rational_perm.dat Contains all authorized Go to License Key Center to
user permanent license request permanent keys.
keys.

rational_server_temp.dat Contains all temporary Obtain a permanent license
floating license keys on a | key to continue to use your
license server. IBM Rational product.

rational_server_perm.dat Contains all permanent Go to License Key Center to
floating license keys on a | request new permanent license
license server. keys.

The floating license server line
This section explains the line used to set up a license server in the license key file.

A typical SERVER line is similar to the following example:

SERVER curley  DISK_SERIAL_NUM=12345678
Item in SERVER Line
Description
SERVER Tells the server that the license file will be used for floating or

counted authorized user licenses. This is needed in a floating
license file along with a VENDOR or DAEMON line.

curley The host name of the license server.

Allows the license server’s hostname or IP address to populate the
hostname field in the SERVER line. Both values are allowed. The
hostname value is not encrypted into floating license keys.

12345678 The host ID of the license server.

The default value is the disk serial number (DISK_SERIAL_NUM)
of the user’s boot drive. The host ID value is encrypted into
floating license keys.

curley The hostname of the license server.

Entering the license server name on the client

When you enter the name of the license server in the License Key Administrator
(LKAD) of the client, the LKAD writes the hostname of the license server to an
empty license file in the <rational>\common directory on the client.

License manager daemon (Imgrd)
Two daemons (or processes) are used to manage floating licenses:
* Imgrd, the license manager daemon

¢ vendor daemon
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The Imgrd daemon and the vendor daemon work together to manage the license
keys. The Imgrd handles the initial contact with the client application programs,
passing the connection on to the appropriate vendor daemon. It also starts and
restarts vendor daemons.

By default, the Imgrd on Windows is a Windows NT service.

The Imgrd daemon starts on TCP/IP port 27000 (default) when you start the
server. The Imgrd daemon will assign a random vendor TCP/IP port number
(unless you set up a firewall) to the vendor daemon and start the vendor daemon
on that port.

Vendor daemon

The vendor daemon is a program (rational.exe or ibmratl.exe) developed by
Rational implementing FLEXIm. The vendor daemon keeps track of how many
licenses are checked out and who has them.

The path to the vendor daemon is specified using the VENDOR line in the license

key file. The path to the options file is also specified on the VENDOR line after the
path the vendor daemon. The VENDOR line uses the following syntax:

VENDOR vendor [vendor_daemon path] [[OPTIONS=]Joptions_file path] [[PORT=]port]
For example, a typical VENDOR line for Windows systems is displayed as:
VENDOR rational D:\Rational\common\rational.exe

or

VENDOR ibmrat1 D:\Rational\common\ibmratl.exe

A typical VENDOR line for UNIX systems is displayed as:

VENDOR rational D:\Rational\common\rational

Where:

Item in VENDOR Line Description

VENDOR The license daemon name and
path are specified in this line.

rational, ibmratl The name of the license server
daemon. Both floating and
authorized user licenses have
this value defined in the
VENDOR string.

<install path>\Rational\common\rational.exe or The path to the Rational

ibmratl.exe License Server executable.

Note: VENDOR lines were known as DAEMON lines in the pre-6.0 versions of
Imgrd and vendor daemon.

License keys are granted by running processes. Only one process, or vendor

daemon, is run to manage keys for all licensed IBM Rational products on the
network.
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If the vendor daemon terminates for any reason, all users lose their licenses (They
do not see a warning that the vendor daemon has terminated). However, this does
not mean the applications suddenly stop running. Users can continue working,
save their work, and exit safely, because the Imgrd (license manager) automatically
restarts the vendor daemon.

The application program communicates with the vendor daemon, usually through
TCP/IP network communications. The application program and the daemon
processes (the license server) can run on separate nodes on your network, across
any size wide-area network.

The format of the traffic between the client and the vendor daemon is
system-independent, allowing for heterogeneous networks. This means the license
server and the computer running an application can use different hardware
platforms or even different operating systems (for example, Windows NT as a
server and Windows 98 as a client).

License server process

When you run a counted licensed application, such as a Rational Suite product,
that uses a floating license, the following occurs:

1. The license module in the client application finds the license key file on the
license server, which lists the host name of the license server and the port
number of the license manager daemon (Imgrd.exe).

2. The client establishes a connection with the license manager daemon
(Imgrd.exe) and specifies the vendor daemon (rational.exe or ibmratl.exe).

3. The Imgrd.exe determines which computer and port correspond to rational.exe
or ibmratl.exe and returns that information to the client.

4. The client establishes a connection with rational.exe or ibmratl.exe and sends its
license request.

5. The vendor daemon checks in its memory to see if any licenses are available
and sends a grant or denial back to the client.

6. The license module in the application grants or denies use of the feature, as
appropriate.

The options file for floating licenses

54

Rational provides the least restrictive licensing environment possible. By default,
the server does not restrict access to any client requesting a license key. This
configuration works best for most customers.

If you want a more controlled floating license environment, you can use the
options file to reserve or deny licenses for certain users, hosts, displays, groups, or
IP addresses. You can also limit the number of licenses each user or group can
access.

Setting up the options file
To create an options file:

1. Using a text editor create a text file, rational.opt, in the <rational>\common
directory.

2. Enter the following commands in the file. See [“Example 1” on page 55/ and
[“Example 2” on page 55| for the correct syntax.

Options File Commands Description
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RESERVE Tells the server to reserve a license

1 The number of licenses to reserve
ClearQuest The name of the license to reserve
USER Tells the licensing software to reserve a license for

a specific user ID

greg The userid for which the license will be reserved

Note: For the server to recognize the file or any changes made to it, restart the
license server. You will have to stop and then start the license server. The
Imreread diagnostic tool will not work.

Example 1

You have 10 floating licenses of ClearQuest. You want to ensure that users Greg
and Peter always have a license of ClearQuest available for their use. Set up the
options file as follows:

RESERVE 1 ClearQuest USER greg
RESERVE 1 ClearQuest USER peter
Example 2

You have 10 floating licenses of ClearQuest. You want to ensure that user Bob does
not have access to a ClearQuest license. Set up the options file as follows:

EXCLUDE ClearQuest USER bob

Diagnostic tools

Imtools

Imutil

The Imtools application is designed to help diagnose licensing problems. It is
available on Windows only. This application is installed with all products in the
<rational>\common directory. If the license server is installed, you can use the
License Tools Start menu to access the Imtools GUI.

By default, the Imutil program is installed in the <rational>\common directory. The
command Imutil is fully supported and has a number of useful options. More
information can be found in the FLEXIm End Users Guide, Chapter 7, at
http://www.macrovision.com/pdfs/flexIm licensing end user guide.pdf.

Imreread

The Imutil Imreread command is a supported option that forces the server to
source the license file without having to shut down the server. This allows systems
administrators to make changes to the license file without stopping and restarting
the server.

Note: The Imutil Imreread command does not detect changes to the options file.
For more information about the options file, see [“Setting up the options file”|

on page 54
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Chapter 7. Troubleshooting licenses

This chapter provides possible solutions based on commonly asked questions and
error messages.

The commonly asked questions are sorted into the following topics:

* |“Authorized user licenses” on page 57}

* |“License server and floating licenses” on page 57}

* [“Moving license keys” on page 58

+ |“License Key Center data entry” on page 58
* ["Host ID” on page 58|
* [“Upgrades” on page 59|

+ [“Error messages” on page 60}

For more information on commonly asked questions, see the Frequently Asked
Question documents on the [Licensing Web page|at http://www.ibm.com/software/
rational/support/licensing/.

A list of Windows and UNIX error messages and possible solutions are in

and [Table 11

Authorized user licenses

Does a change in the IP address and internet address affect the authorized user
license?

Authorized user licenses use the host ID (disk_serial_num) or ethernet address of
the licensed computer. Therefore, a change in the IP address or a change in
Internet address does not affect your license. However, you should notify IBM
Licensing Support if the e-mail address of the license contact has changed.

License server and floating licenses

Can an IBM Rational product on a client in one Windows domain obtain licenses
from a license server that is on a different Windows domain?

Yes, it is possible. If the client can see the license server by host name, the request
will work. IBM licensing also supports using the fully qualified domain name or
using the IP address of the license server instead of the host name.

How do I install licensed software on a second disk? I have a second disk on my
computer and I have requested a floating license for <product>.

Provide the correct host name, host ID, and account number for the second disk in
License Key Center. Then install the software on the second disk and import the

permanent license key that you receive from License Key Center on the second
disk.

How do I restart my master license server? I have redundant servers and I cannot
restart my master server.
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To restart a server in a redundant server configuration, restart all the servers in no
particular order. You cannot just restart the server that has gone down.

Moving license keys

How long does it take to move a license key to another computer?

The requests for returning and getting a new license key usually take no longer
than your initial license request.

How do I move a authorized user license mistakenly installed on a
database/repository server to a client? We purchased two authorized user licenses
for two client computers. I made a mistake and requested and installed one of the
licenses on the database or repository server. I cannot install this license on the
second client because it is system-specific.

To move and return license keys, see [Chapter 12, “Returning or moving keys for]
[desktop users,” on page 87

License Key Center data entry

What is my Account Number? I just downloaded the upgrade to <product>. I am
now unable to run the software. I do not know my Account Number which is a
required field in License Key Center.

Use the account number specified on your Proof of Entitlement certificate. If you
cannot find your Proof of Entitlement certificate, contact IBM support for Rational
products with your purchase order or sales order number.

Host ID

What should I do if I need to reformat the hard drive on my computer?

You need to replace your license keys in case the host ID changes on your
computer during the reformat.

1. Return your license keys to IBM. Go to License Key Center.
2. Perform the reformat.
3. Order new license keys from IBM through License Key Center.

What should I do if I am upgrading the operating system on my computer?

If you do not need to reformat your hard drive to do the upgrade, your licenses
stay on your computer in the Rational/Common directory. After you perform the
upgrade, all of your licenses should still be available. If you need to reformat the
disk, see the previous question in this section.

What if my license .dat files get deleted?

Go to License Key Center and get copies of the license files.

The host ID fffttttf is not valid. Why? fftfttff is the value listed in the host ID field
in the License Manager.
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When you initialized your disk, your disk did not receive a disk_serial num.
Although the software accepted this entry, licensing services regards this value as
invalid.

You can reset your host ID by using vendor disk utility tools such as those by
Norton. Another option is to use the Ethernet card address instead of the host ID.

I changed my file system from FAT to NTFS, which changed my host ID. Could
you please change my key to make it work again? I changed my system disk and
the licenses no longer work.

The license keys are generated for a specific host name and host ID. You have to
return the license keys to your IBM Rational account and then request license keys
for the new host ID. To perform these transactions, go to License Key Center.

Upgrades

We received two upgrade packets but chose not to upgrade immediately because
we were in the middle of pre-release testing. The Proof of Entitlement certificate
says, however, that the key expires on <date>.

Contact your IBM Sales Office to obtain temporary license keys that will work
until you are ready to upgrade your computer.
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Error messages
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[Table 10 and [Table 11| explain licensing error messages for Windows and UNIX,

respectively.

Table 10. Licensing error messages (Windows)

Message or Description

Action

¢ Cannot find SERVER hostname in
network database

e Cannot connect to license SERVER
* NO SUCH FEATURE EXISTS

* Failed to check out a <product-name>
key

Confirm on the desktop:

* You have entered the correct name for the
license server (in the Client/Server
Configuration window of the License Key
Administrator or the Manage Licenses wizard
of the IBM Installation Manager). For more
information, see [“Checking the Windows client|
[configuration” on page 64

* You have entered the correct vendor port
number if there is a firewall between the client
and the license server. For more information,
see [“Using floating licenses with a firewall” on|

|Eage 33|

* The network connection between the client
and the license server is working. For more
information, see ['Checking the Windows|
[network connection” on page 63|

Confirm on the license server:

* The license server (Imgrd) and the rational.exe
or vendor daemon are running. See |”Checkin§|
[the Windows license server” on page 62|

* There are numbers assigned to the Imgrd and
vendor ports on the license server (if there is a
fire wall between the license server and the
client). For more information, see |”Usina
[floating licenses with a firewall” on page 33}

In all cases, if you do not see any problems with
the network connection or the license file, yet
applications cannot acquire license keys, stop
and start the license server from the License
Manager (See [“Starting the Windows license]

[server” on page 27). It may also be helpful to

reboot the server, particularly if the license
manager is running as an NT service. If all else
fails, contact IBM support for Rational products.
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Table 10. Licensing error messages (Windows) (continued)

Message or Description

Action

License keys are not for this machine.

The license was not intended for this
server.

* You are installing the license key on a
computer other than the one for which the
license key was generated. The Ticense.upd
file specifies the computer name and host ID
that you entered in the license key request to
License Key Center. Import the file on the
correct computer.

* Confirm that the license key file you received
contains the correct host ID and hostname of
the license server or client. To find this
information, use a text editor to view the
license key (*.dat) file in <Install Path>\1BM
Rational\Common\.

¢ Compare the Disk Volume Serial Number
found in License Tools > System Settings,
with what is displayed in the Server line in the
license key file. These two numbers should
match. Occasionally 0 or a dash will be found
in the license file.

The license for this product will expire...

Your temporary or Term License Agreement
(TLA) license key is nearing its expiration date.
This warning message is displayed every time
you start the application until you install a
permanent license key or another TLA license
key. To continue using the product, contact your
IBM sales representative to purchase the product
or extend your TLA.

You can turn off the warning by clicking
Settings > Display Expiration Warnings in the
License Key Administrator.

Table 11. Licensing error messages (UNIX)

Message

Explanation/Action

There is a problem with one license key.
or

There are problems with <N> license
keys.

This means that the license keys in the license
file do not match and are inconsistent with the
text of the license. The licenses consist of several
parameters and a 12-digit hexadecimal key that
was created using these parameters. The
parameters are in ASCII text but they cannot be
changed or it will invalidate the license. The
parameters used to create the license are the
server host ID, license name, vendor daemon
name, expiration date, number of users
(quantity), VENDOR_STRING, OVERDRAFT,
SUPERSEDE, DUP_GROUP, and NOTICE.

You do not have remote access to
<license-server-name> from
<local-host-name>, so it cannot be set up
as a license server.

It may be that the license server is not the same
computer on which you are installing. You must
have remote shell access (rsh or remsh) to the
license server.
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Table 11. Licensing error messages (UNIX) (continued)

Message

Explanation/Action

Host <license-server-name> is running
Solaris.

Host <local-host-name> is running
HP-UX.

They do not match so
<license-server-name> cannot be used as
a license server.

It may be that the license server is not the same
computer on which you are installing. If so, it
must run the same operating system that the
product you are installing requires.

Host, <license-server-name> does not
have access.

If the license server is not the same computer on
which you are installing, it must have access to
the Rational directory where IBM Rational
products have been installed.

Cannot set <license-server-name’s> host
ID with this command:

rational_dir/base/cots/

flexIm.7.0f/Imhostid

The Imhostid command failed. Check to see if
the Imhostid command shown will run on your
local host. If so, enter the host ID number in the
License Server Host ID Menu (choice number
2).

Cannot access
rational_dir/base/cots/

flexIm.7.0f/Imhostidon
<license-server-name>.

There was a problem accessing the rational_dir
directory or the Imhostid command was not
installed from the CD.

Host ID <nnn> not valid. Less than 4
digits.

This means that the host ID number will not
work. Check again using the Imhostid to see
what the host ID is. It should be at least four or
more hexadecimal digits.

Port number <pn> is in use in
/etc/services. or

Port number <pn> is in use under NIS
services.

If you entered a port number and it seems that
the number is in use in your /etc/services file or
under NIS services, you may have a problem
with licensing.

IBM Rational products that use FLEXIm use
TCP/IP sockets to communicate with a license
server using a specific port number. This port
number is specified in the license file on the
SERVER line. The license server will not be able
to open a socket on a port that is already in use.
Use the default port number, 27000.

Checking the Windows license server
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Use the following procedure to determine whether one or both of the license
daemons, Imgrd.exe and rational.exe or ibmratl.exe, is not working.

1. Click Start > Programs > Rational License Server > License Tools. This
brings up Imtools, a FLEXIm utility that is a GUI version of the command line

utility Imutil.

2. In the Service/License File tab, select Configuration using License File and
enter the complete path (including drive letter) to the license file on the license

server in the text box.

3. Go to the Server Status tab. Select Display Everything and click Perform

Status Inquiry button.
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a. If the license server is running, you will see the following lines in the status
output window:

server_hostname: license server UP (MASTER) v_number
Vendor daemon status (on server_hostname):
rational: UP v_number

The first line refers to the status of Imgrd.exe, the second line to the status
of the vendor daemon.

Because the Rational license server software is running, the problem may be
the network communication between client and server. See |“Checking the

[Windows network connection” on page 63}

b. If Imgrd.exe is running, but rational.exe or ibmratl.exe is not, the following
lines are displayed in the status output window:

server_hostname: Ticense server UP (MASTER) v_number
Vendor daemon status (on server_hostname):

rational [or] ibmratl: The desired vendor daemon is down.
Use the following methods to start the rational.exe or ibmratl.exe:

¢ The daemon <vendor name> was unexpectedly terminated and Imgrd has
not yet restarted it. Select the Stop/Reread tab in the License Tools utility.
Expand the Remote Server List and select rational. Click the Reread License
File button.

* The license file does not correctly specify the path to the vendor daemon in
the line. For example: DAEMON rational [complete path to rational.exe or
ibmratl.exe, including drive letter].

¢ The version of Imgrd.exe may be incompatible with rational.exe or
ibmratl.exe. You already have FLEXIm (Imgrd.exe) installed on the license
server. Confirm that the date and size of the file install_directory\ common\
Imgrd.exe matches the Imgrd.exe found in the \common directory of the
product installation CD.

c. If both Imgrd.exe and the vendor daemon are not running, the resulting
status output window will contain the lines:

Imgrd is not running: Cannot connect to server
FLEXTm error: -15.10.

Use the following methods to start the Imgrd.exe and the vendor daemon:
* Review the setup and start instructions for the Rational license server.

* There may be a phantom vendor daemon process running. This occurs when the
Imgrd process is terminated unexpectedly. Press Ctrl-Alt-Del to bring up the
Task Manager. On the Processes tab, look for rational.exe or ibmratl.exe and/or
Imgrd.exe. Terminate these processes. Start the license server (see
[Windows license server” on page 27) and check the Server Status in Rational
License Server > License Tools. If the license server is still not running, and it
is configured to run as an NT service, restart the computer twice.

¢ The FLEXIm License Manager application may be out of date or corrupted.

Checking the Windows network connection

Use the following procedures to check the network connection between the license
server and the client.

1. On the client, bring up an MS-DOS window by clicking Start > Run and
typing emd in the Open text box.
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2. At the command prompt, type: ping server_hostname.

If you see an IP address appear, a computer of that host name has responded.
There may be more than one computer on the network with the same host name.
To make sure the IP address that you see in the Window is the server’s IP address,
check the IP address of the server.

To find the IP address of the license server:

a. Go to your license server and click Rational License Server > License Tools.
b. Click the System Settings tab in the LMTools dialog box.

C. Check the IP address under Hostid Settings.

If you cannot ping the license server by hostname, ping it by its IP address. If this
is successful, you will have to either correct the name resolution problem on your
network or replace the host name with the IP address in the license key file.

To replace the host name in the license key file:

a. In install_directory\Rational\common of the license server, look for the file
rational _server perm.dat.

b. Replace the host name with the IP address in the line that begins with SERVER:
SERVER server_hostname server_hostid...
Do not change the server_hostid and the vendor daemon information on this
line.

c. Enter the IP address of the server in the LKAD'’s Settings > Client/Server
Configuration dialog box.

Checking the Windows client configuration

Use the following list to check whether the IBM Rational Team software client is
correctly configured for IBM Rational Common Licensing (powered by FLEXIm
software).

¢ Check the entry or entries for the license servers in the Client/Server
Configuration window of the desktop’s LKAD. If you are unsure about the
format in which the server hostname should be entered, go to your Rational
license server and click Rational License Server > License Tools. This opens
LMTools, a FLEXIm utility that is a GUI version of the command line utility
Imutil.

Click the System Settings tab in the LMTools window. Check the entry next to
Computer/Hostname under Hostid Settings.

¢ In the client’s Windows registry, look under HKEY_LOCAL_MACHINE\
SOFTWAREN\IBM Rational\Licensing\1.0. The value “Serve List” should have
the server host name.

Technical notes

The IBM Web site contains technical notes about additional licensing issues. New
technical notes appear on a regular basis. To find the technotes, go to
http://www.ibm.com/software/rational.

1. Under Rational, select the Support tab, and then select Search.

2. You can search for licensing topics in the search engine. Search result options
include troubleshooting documents, such as technical notes, by default.
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Part 2. Client setup for Rational software
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Chapter 8. Before installing license keys

This chapter introduces you to the basic tasks for licensing your IBM Rational
products. Information and procedures in Part 2 apply to all IBM Rational products
included in Rational Common Licensing, except tools built on the Eclipse platform.

(See Part 3 for information on supporting Floating licenses for IBM Rational
Software Development Platform products built on the Eclipse platform.)

[Table 12| and [Table 13| describe common desktop licensing tasks and direct you to

the correct section and page for instructions. If you are upgrading your

environment, see [“Upgrading license keys” on page 69

directs you to procedures for entering, importing, and requesting licenses
for your IBM products.

Table 12. Getting started with IBM Rational Common Licensing

Task

Scenario

Procedure

Get your permanent
(or Fixed Term
License) license key.

Fixed Term License
means the license key
has an expiration date
built into it.

You have purchased
a authorized user,
floating, or
named-user floating
licenses.

Use your Proof of Entitlement certificate to
request permanent license keys from License
Key Center, the Rational Web-based license
key management tool.

See |Chapter 2, “Requesting license keys,” on|
|Eage 13| for more information about the
License Key Center.

Get your evaluation
license key.

You want to evaluate
an IBM Rational
product.

Your IBM sales representative sends you or
your license administrator an evaluation
license key.

You either install a authorized user key on
your desktop or point your desktop client to
a Rational license server that your license
administrator has set up for you.

Install authorized
user license keys on
your desktop.

You received a
authorized user
license key.

Use the License Key Administrator (LKAD)
wizard to install your authorized user
license keys. The LKAD wizard launches at
the end of product installation. If it does not
launch, open the LKAD from the Start menu
under the Rationalfolder.

See |Chapter 9, “Installing authorized user|
[license keys,” on page 71| for more
information.

Configure your client
desktop to request
floating licenses from
the license server.

Your license
administrator has set
up an IBM Rational
license server to
serve floating license
keys to desktop
clients.

Get the name of the license server from your
administrator. Then use the License Key
Administrator (LKAD) wizard to specify the
license server. The LKAD wizard launches at
the end of the product installation. If it does
not, open the LKAD from the Start menu
under the Rational folder. See |Chapter 8,|
|“Before installing license keys,” on page 67}

able 13| provides page numbers for advanced user tasks that you may have to
perform; for example, you may have to change desktops or you want your client
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desktop to request a point product license before a Suite license.

Table 13. Additional desktop tasks

Task

Procedure

Change the order in which IBM Rational
products use licenses.

Chapter 11, “Changing license usagel|

order,” on page 81|

Move or return license keys.

Chapter 12, “Returning or moving keys|

for desktop users,” on page 87]

Use license keys for home or travel.

“Using license keys for home use orf

travel” on page 69|

See the IBM Rational product or UNIX
installation guide.

Configure UNIX clients.

To configure a UNIX license server for Windows |[Chapter 4, “Configuring a UNIX license]
clients. server,” on page 35|

Opening the License Key Administrator (LKAD)

The IBM Rational License Key Administrator (LKAD) is installed with many IBM
Rational products and with your Rational License Server software. This application
provides an interface to IBM Rational Common Licensing (powered by FLEXIm
software). Use the LKAD or the LKAD wizard to enter or import license keys and
change your license configuration.

Note: For IBM Rational products built on the Eclipse framework, use the IBM
Installation Manager to manage your license configuration on the desktop.

* To access the LKAD and the LKAD wizard on a desktop, click Start >
Programs > IBM Rational > Rational License Key Administrator.

e To access the LKAD and the LKAD wizard on the license server, click Start >
Programs > IBM Rational > Rational License Server > Rational License Key
Administrator.

Note: You must have administrative privileges on the computer before you can
enter or import license key information in the LKAD.

To access the Help, click Help in the License Key Administrator’s main menu, click
Help in the LKAD wizard, or open <Install Path>\1BM Rational\doc\help\
Ticadmin\index.htm.

Administrator Privileges for the LKAD

68

You must have certain administrative privileges to complete tasks in the License

Key Administrator (LKAD). If you cannot perform a task in the LKAD, it might

mean that you are missing local administrative privileges on that computer.

Grayed out menu options in the LKAD wizard, menu bar, or button bar indicate

limited privileges.

1. To see which privileges are missing, select Help > About Rational License
Key Administrator. You may see one or more of the following statements.

Statement Explanation

Cannot write to HKEY_LOCAL_MACHINE in | You cannot specify a license server.
the Windows Registry.

Cannot Start and Stop a Windows Service. You cannot start the license server.
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Statement Explanation

Cannot create a file. You cannot import a license key file on to
your computer.

Cannot modify a file. You cannot enter a temporary license key
in your computer.

2. Request the missing Windows administrator privileges from your system
administrator.

Upgrading license keys

If you are upgrading from an earlier version of an IBM Rational Suite or
point-product, for example version 2003.06.00, re-use your current Rational Suite
and point-product keys.

You must order new license keys in License Key Center under the following
conditions:

* If you have purchased a different edition of Rational Suite from the one that you
are currently using, return the license file and request a new license file that
includes the new Rational Suite key.

— See|Chapter 12, “Returning or moving keys for desktop users,” on page 87| or
[Chapter 5, “Returning or moving keys for administrators,” on page 49| for
returning the existing key.

- See|Chapter 2, “Requesting license keys,” on page 13| for requesting
permanent or TLA license keys.

* If you are adding a new product to your system, return the license file and
request a new license file that includes the new product license key.

— See|Chapter 12, “Returning or moving keys for desktop users,” on page 87| or
[Chapter 5, “Returning or moving keys for administrators,” on page 49| for
returning the existing key.

— See [Chapter 2, “Requesting license keys,” on page 13| for requesting
permanent or TLA license keys.

* If you have upgraded to a different variant of IBM Rational Rose, remove the
existing variant and install the new variant and license key.

Using license keys for home use or travel

If your product uses floating keys, with disconnected mode you can use IBM
Rational software at home for a 3-day period. You must activate disconnected use
within a 3 day period of acquiring a floating license key and disconnecting from
the network at work. After you activate disconnected use, you can use the software
for 3 days from the day and time that you activate the disconnected use.

For example, you acquire a floating key for IBM Rational ClearCase LT at 4 p.m.
on Friday and disconnect from the network and go home. Because you plan to
work at home during the next week, you must activate disconnected use within
the 3-day period of acquiring the key and disconnecting from the network. If you
launch ClearCase LT by 3:30 p.m. on Monday, you can use Rational ClearCase LT
until 3:30 p.m. on Thursday. If you do not launch Rational ClearCase LT before 4
p-m. on Monday, you will lose disconnected use of Rational ClearCase LT.

Disconnected use of floating licenses on a UNIX license server is not supported.
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There are two other options for home use or travel:
* Depending on whether it is available for your product, you can use authorized
user keys instead.

* Rational ClearCase LT provides snapshot views. Snapshot views of your work
do not require network connectivity; therefore, a license key is not necessary.

Changing the disconnect time-out to delay disconnected use

If you have a slow network at work, your software automatically goes into
disconnected use mode if it does not receive a response from the license server
within 5 seconds. You then see a window that states that you are in disconnected
use mode after the 5 seconds.

Starting with release 20014, you can change the time-out period before your IBM
application goes into disconnected use mode. The default setting is 5 seconds. To
change the setting:

1. Create a DWORD key: HKEY_LOCAL_MACHINE\SOFTWARE\IBM
Rational\Licensing\1.0\DisconnectTimeout

2. Modify the value (decimal) to be more than 5 seconds.
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Chapter 9. Installing authorized user license keys

This chapter describes how to install permanent, term license agreement, and
temporary authorized user license keys on desktops. An authorized user license
key is created for a specific desktop and does not require a license server.
Authorized user license keys allow for portability, especially for customers who
have isolated computers or laptops.

 If you are a client desktop user and need to use floating or named-user floating
license keys, see [Chapter 10, “Configuring clients to use floating keys,” on page|

* If you are the license administrator and need to install the floating or

named-user license keys on a Rational license server, see thapter 3,|
“Configuring a license server for Windows systems,” on page 19| or [Chapter 4,
“Configuring a UNIX license server,” on page 35}

Opening the License Key Administrator (LKAD)

The IBM Rational License Key Administrator (LKAD) is installed with many IBM
Rational products and with your Rational License Server software. This application
provides an interface to IBM Rational Common Licensing (powered by FLEXIm
software). Use the LKAD or the LKAD wizard to enter or import license keys and
change your license configuration.

Note: For IBM Rational products built on the Eclipse framework, use the IBM
Installation Manager to manage your license configuration on the desktop.
* To access the LKAD and the LKAD wizard on a desktop, click Start >
Programs > IBM Rational > Rational License Key Administrator.
e To access the LKAD and the LKAD wizard on the license server, click Start >

Programs > IBM Rational > Rational License Server > Rational License Key
Administrator.

Note: You must have administrative privileges on the computer before you can
enter or import license key information in the LKAD.

To access the Help, click Help in the License Key Administrator’s main menu, click
Help in the LKAD wizard, or open <Install Path>\1BM Rational\doc\help\
Ticadmin\index.htm.

Reviewing your license information in the LKAD

By default, you should see complete information about your license keys in the
main window of the License Key Administrator. If you do not see this information
in the window, use the View > Show menu to display information about your
licenses.

The following table defines each of the options in the View > Show menu.

Table 14. Show licenses

License Shows
Invalid and expired licenses All expired authorized user, floating, and served
licenses on the system that you are using.
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Table 14. Show licenses (continued)

License

Shows

Floating licenses

All floating licenses on the system that you are
using.

Authorized user licenses

All authorized user licenses on the desktop that
you are using.

Served licenses

All floating licenses that IBM software on your
system could request from the license server.

Installing permanent or temporary keys

Request permanent authorized user license keys from the Rational License Key
Center. License Key Center sends you a permanent license file. This file contains
license keys for the desktop that you specified in License Key Center.

Importing permanent authorized user keys
Use the License Key Administrator (LKAD) to import the license key file on your

desktop after you install the product.

Note: You must have local administrative privileges for the computer to import

the license key into the LKAD.

To import a license key file in the LKAD:

1. Click License Keys > Import License Key(s).
2. In the Import License Key(s) window, find the *.upd or *.txt file (license key

file) and select it.

3. Click Open. The default location for the license key file is <Install Path>\1BM

Rational\Common.

4. Click Import in the Confirm Import window.

Other methods

* If your e-mail program supports launching programs from file attachments,
double-click the .upd or .txt attachment in the e-mail notification that you
received from License Key Center. Select Open it in the Opening Mail
Attachment window. Click Import in the Confirm Import window.

* Save the file attachment to any folder and double-click the license file.

¢ Use the LKAD wizard.

Entering temporary or evaluation license keys

You can find the license key information for temporary or evaluation licenses in

the following sources.

* Your IBM sales representative gives you an evaluation license key.

* The temporary license key is in your Proof of Entitlement certificate.

Entering temporary authorized user license keys

Temporary authorized user license keys can be entered in the LKAD. Launch the

LKAD after installing the product.

Note: You must have local administrative privileges for the computer to import

the license key into the LKAD.
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To enter license information in the LKAD:
1. Click License Keys > Enter a License in the License Key Administrator.
2. Select the type of license.
3. In the next window, enter the following information:
* Product
* Expiration Date
* License Key
* Quantity (if you are installing a floating license key)

4. Click Finish. The License Key Administrator adds this information to the
license key *.dat file in <Install Path>\1BM Rational\Common.
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Chapter 10. Configuring clients to use floating keys

IBM Rational products on a Windows client desktop can check out floating and
named-user floating license keys from a Windows or UNIX license server. This
chapter explains how to specify a license server in your client desktop’s License
Key Administrator (LKAD).

In the following four situations, you do not have to open the LKAD and specify
the license server:

* Your system administrator has set up a silent installation. The silent installation

may include a post-installation command that specifies the license server. For
more information about the silent installation command syntax, see the
installation guide for your IBM Rational product.

* Your administrator may give you a text file to run from a command window.
See [“Running the License Key Administrator command line” on page 78}

* Your administrator may have included the license server name in a site defaults

file in a network release area. When you install the product from the release
area, you do not have specify the license server in your client desktop LKAD.

For more information about installing IBM Rational products from a release area,

see the installation guide for your IBM Rational product.
* Your computer is also the Rational license server.

If you have a authorized user license, see [Chapter 9, “Installing authorized user|
[license keys,” on page 71|

Use [Table 15| to guide you through this chapter.

Table 15. Floating license tasks on clients

Task Procedure

Open the License Key Administrator “Opening the License Key Administrator|
(LKAD). (LKAD)” on page 76}

Configure the client desktop to use a “Configuring clients to use Rational license|
single or multiple license servers. servers” on page 76|

Configure the client desktop to use “Configuring clients to use Rational license|
redundant license servers. servers” on page 76|

Assign a port value in a firewall “Configuring clients to use Rational license|
situation. servers” on page 76|

Change the license server search order. |[“Configuring clients to use Rational license]
servers” on page 76|

Remove a license server from the search |[“Removing a license server from the server|

order. search order” on page 78|

Use the License Key Administrator “Running the License Key Administrator|
command line. command line” on page 78|

Use floating license keys when you “Using license keys for home use or travel” on|
work at home or travel. page 78|
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Opening the License Key Administrator (LKAD)

The IBM Rational License Key Administrator (LKAD) is installed with many IBM
Rational products and with your Rational License Server software. This application
provides an interface to IBM Rational Common Licensing (powered by FLEXIm
software). Use the LKAD or the LKAD wizard to enter or import license keys and
change your license configuration.

Note: For IBM Rational products built on the Eclipse framework, use the IBM
Installation Manager to manage your license configuration on the desktop.
* To access the LKAD and the LKAD wizard on a desktop, click Start >
Programs > IBM Rational > Rational License Key Administrator.

* To access the LKAD and the LKAD wizard on the license server, click Start >
Programs > IBM Rational > Rational License Server > Rational License Key
Administrator.

Note: You must have administrative privileges on the computer before you can
enter or import license key information in the LKAD.

To access the Help, click Help in the License Key Administrator’s main menu, click
Help in the LKAD wizard, or open <Install Path>\1BM Rational\doc\help\
Ticadmin\index.htm.

Reviewing your license information in the LKAD

By default, you should see complete information about your license keys in the
main window of the License Key Administrator. If you do not see this information
in the window, use the View > Show menu to display information about your
licenses.

The following table defines each of the options in the View > Show menu.

Table 16. Show licenses

License Shows

Invalid and expired licenses All expired authorized user, floating, and served
licenses on the system that you are using.

Floating licenses All floating licenses on the system that you are
using.

Authorized user licenses All authorized user licenses on the desktop that

you are using.

Served licenses All floating licenses that IBM software on your
system could request from the license server.

Configuring clients to use Rational license servers

Enter the license server’s host name in the License Key Administrator (LKAD) of
your client. Your license administrator should tell you whether the license server
has been started before you specify the license server.

Configuring clients to use single or multiple license servers

Use the following procedure to specify one or multiple license servers on your
client. Do not use the following procedure to enter redundant servers.

76  IBM Rational : License Management Guide



To enter the license server hostnames on a desktop:
1. Select Settings > Client/Server Configuration.
2. Click Add Server.

3. Single should be the default value next to Server Type. Enter the host name of
the license server in the Values column next to Server Name by clicking
New-Server. Press Enter after entering the host name.

Additional Servers

If your system administrator has given you the host names of additional license
servers, click the Add Server button and enter the host name for each server. Click
OK after you have entered all servers.

Your desktop applications request licenses from servers in the order that you enter
the servers in the LKAD. If you want to change this order, see |“Changing the

[server search order” on page 77

Configuring clients to use redundant license servers

Redundant servers are a system of three servers that work as a team to manage a
single pool of floating license keys. If one of the servers goes down, the other two
license servers automatically continue managing the license pool.

To enter the redundant license servers on a desktop:

1. Select Settings > Client/Server Configuration.

2. Click Add Server.

3. Click Single next to Server Type; then click Redundant in the pop-up menu.
4.

Enter the Primary, Secondary, and Tertiary license server hostnames in the
order in which the license administrator requested them in License Key Center.
Press Tab to move to the next line.

5. Click OK.

Entering a port value to support a firewall

Assigning a value to the port in your License Key Administrator is necessary in
firewall situations. Do not assign a value to this port unless your administrator
instructs you to do so. To learn more about Rational licensing and firewalls, see
[“Using floating licenses with a firewall” on page 33| The following procedure
assumes the license administrator has given you the Rational vendor port value.

To enter a port value on a desktop:

1. Select Settings > Client/Server Configuration.
2. Enter the value in the Port field.

3. Click OK.

Changing the server search order

You can change the order in which Rational applications on your client desktop
access license servers. The license server list is displayed in the Client/Server
window. The task of changing the server search order does not affect the order in
which IBM Rational products request licenses from a server. If you have a
combination of authorized user, floating, suite, and point-product license keys in
your environment, see [Chapter 11, “Changing license usage order,” on page 81}
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If you would like to change the server search order, select the license server in the
list and click the Up or Down button to change its position. Click OK to complete
the change.

Removing a license server from the server search order

If your system administrator tells you that one of the Rational license servers has
to go offline, you can remove it from the server search order without deleting the
information from the LKAD.

To remove a server from the server search order:

1. Select Settings > Client/Server Configuration.

2. Find the license server in the Search Order list and clear the check box next to
it.

3. Click OK.

When the license server goes back online, you can select the check box next to it.

Removing the license server from your client desktop

If you know that the license server will not be used in the future, remove the
server from the Client/Server Configuration window by selecting the server name
and then clicking Remove Server.

Running the License Key Administrator command line

To automate licensing, your administrator may have you run the License Key
Administrator from the command window.

To specify a single, multiple, or redundant license server from the command line:
1. Move the text file that your administrator gives you to any directory.
2. Open a command window and navigate to that directory.
3. Enter the following command:
licadmin -ffilename.txt

where filename.txt is the text file that contains the license parameter
commands.

The results of running this command are written to the status file
filename.txt_STATUS. The status file is created in the directory where you ran the
licadmin command.

Using license keys for home use or travel

78

If your product uses floating keys, with disconnected mode you can use IBM
Rational software at home for a 3-day period. You must activate disconnected use
within a 3 day period of acquiring a floating license key and disconnecting from
the network at work. After you activate disconnected use, you can use the software
for 3 days from the day and time that you activate the disconnected use.

For example, you acquire a floating key for IBM Rational ClearCase LT at 4 p.m.
on Friday and disconnect from the network and go home. Because you plan to
work at home during the next week, you must activate disconnected use within
the 3-day period of acquiring the key and disconnecting from the network. If you
launch ClearCase LT by 3:30 p.m. on Monday, you can use Rational ClearCase LT
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until 3:30 p.m. on Thursday. If you do not launch Rational ClearCase LT before 4
p-m. on Monday, you will lose disconnected use of Rational ClearCase LT.

Disconnected use of floating licenses on a UNIX license server is not supported.

There are two other options for home use or travel:

* Depending on whether it is available for your product, you can use authorized
user keys instead.

* Rational ClearCase LT provides snapshot views. Snapshot views of your work
do not require network connectivity; therefore, a license key is not necessary.

Changing the disconnect time-out to delay disconnected use

If you have a slow network at work, your software automatically goes into
disconnected use mode if it does not receive a response from the license server
within 5 seconds. You then see a window that states that you are in disconnected
use mode after the 5 seconds.

Starting with release 2001A, you can change the time-out period before your IBM
application goes into disconnected use mode. The default setting is 5 seconds. To
change the setting:

1. Create a DWORD key: HKEY_LOCAL_MACHINE\SOFTWARE\IBM
Rational\Licensing\1.0\DisconnectTimeout

2. Modify the value (decimal) to be more than 5 seconds.
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Chapter 11. Changing license usage order

IBM Rational products request licenses in a specific order. If you have a
combination of authorized user, floating, suite, and point-product license keys in
your environment, you need to understand this license usage order and how you
can change it. To understand the explanation in the following sections, you must
know the definitions of the license types. For more information, see |”Deﬁnina
[license types” on page 6|and [“Using point-product keys and suite keys” on page 8

Understanding license usage order

An IBM Rational product that uses IBM Rational Common Licensing (powered by
FLEXIm software) requests licenses in this order, by default:

1. Authorized user before a floating license. An IBM Rational product requests a
authorized user license before a floating license regardless of whether it is a
Suite or point-product license.

2. Point-product license before a Suite license. For example, IBM Rational Purify is
sold as part of a Rational Suite and as a stand-alone product. Among a group
of authorized user and floating licenses, Purify will first request a Purify
license, and then request various Rational Suite licenses in a specific order.

3. Suite license of the last Rational Suite installed.

The license key usage order has changed for version 7.0 of IBM Rational products.
In releases before 7.0, when a Suite product was being installed, the Rational
License Key Administrator (LKAD) application would first try to find a license key
corresponding to the Suite. If the Suite key was not available, LKAD would then
look for a key corresponding to the product that was running.

You can use the License Usage Mapper in LKAD to change the release 7.0 license
usage order or have the application not search for any or all Suite keys.

The following table describes the default license usage order for each IBM Rational
product that uses Rational Common Licensing (powered by FLEXIm software).

Table 17. Default license usage order

IBM Rational product Default search order (from first to last)
ClearCase ClearCase
ClearCase LT ClearCase LT, Rational Suite Enterprise,

Rational Suite Team Unifying Platform™,
Rational Suite DevelopmentStudio, Rational
Suite TestStudio®, Rational Suite
AnalystStudio, Rational Suite
DevelopmentStudio RealTime

ClearQuest ClearQuest, Rational Suite Enterprise,
Rational Suite Team Unifying Platform,
Rational Suite DevelopmentStudio, Rational
Suite TestStudio, Rational Suite
AnalystStudio, Rational Suite
DevelopmentStudio RealTime
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Table 17. Default license usage order (continued)

IBM Rational product

Default search order (from first to last)

ProjectConsole™

ProjectConsole, Rational Suite Enterprise,
Rational Suite Team Unifying Platform,
Rational Suite DevelopmentStudio, Rational
Suite TestStudio, Rational Suite
AnalystStudio, Rational Suite
DevelopmentStudio RealTime

Purify

Purify, PurifyPlus, Rational Suite Enterprise,
Rational Suite TestStudio, Rational Suite
DevelopmentStudio, Rational Suite
DevelopmentStudio RealTime

PurifyPlus

PurifyPlus, Rational Suite Enterprise,
Rational Suite DevelopmentStudio, Rational
Suite DevelopmentStudio RealTime

Quantify

Quantify, PurifyPlus, Rational Suite
Enterprise, Rational Suite TestStudio,
Rational Suite DevelopmentStudio, Rational
Suite DevelopmentStudio RealTime

PureCoverage

PureCoverage, PurifyPlus, Rational Suite
Enterprise, Rational Suite TestStudio,
Rational Suite DevelopmentStudio, Rational
Suite DevelopmentStudio RealTime

RequisitePro

RequisitePro, Rational Suite Enterprise,
Rational Suite Team Unifying Platform,
Rational Suite DevelopmentStudio, Rational
Suite TestStudio, Rational Suite
AnalystStudio, Rational Suite
DevelopmentStudio RealTime

Robot

Robot, Rational Suite Enterprise, Rational
TestStudio

Rose Enterprise

Rose Enterprise, Rational Suite Enterprise,
Rational Suite DevelopmentStudio

Rose DataModeler

Rose DataModeler, Rational Suite
AnalystStudio

Rose Modeler

Rose Modeler

Rose C++

Rose C++

Rose Professional J

Rose Professional J

Rose VB

Rose VB

Rose RealTime

Rose RealTime

SoDA®

SoDA for Word, Rational Suite Enterprise,
Rational Suite Team Unifying Platform,
Rational Suite DevelopmentStudio, Rational
Suite TestStudio, Rational Suite
AnalystStudio, Rational Suite
DevelopmentStudio RealTime

Test RealTime

Test RealTime

82 IBM Rational : License Management Guide




Table 17. Default license usage order (continued)

IBM Rational product Default search order (from first to last)

TestManager TestManager, Robot, Rational Suite
Enterprise, Rational Suite Team Unifying
Platform, Rational Suite DevelopmentStudio,
Rational Suite TestStudio, Rational Suite
AnalystStudio, Rational Suite
DevelopmentStudio RealTime

RUP® Not applicable
XDE Not applicable

You may want to customize the license usage order in some cases. For example,
you may want to have a product search for a specific Suite key first. If you would
like to change how your product uses point-product and Suite licenses, see
[‘Changing license usage on your computer” on page 83

RequisiteWeb and ClearQuest Web

RequisiteWeb and IBM Rational ClearQuest Web require floating licenses. Like
other IBM Rational products that use Rational Common Licensing, they request the
point-product license before the suite license.

Rational Rose

Rational Rose uses a license key for the variant of Rational Rose that you install, or
a Rational Suite key that includes that Rational Rose variant. A Rational Rose
variant cannot run with the license key of a different Rational Rose variant. If the
Rational Rose variant installed on your desktop is not included in the suite license
on the Rational license server, you cannot include the Rational Suite license in the
license usage order for that product.

Cross-platform Rational Rose keys

Rational Rose Enterprise can run with a license key for Rational Rose on a UNIX
system. You must change the license usage on your desktop for Rational Rose
Enterprise to run with the license key for Rational Rose on a UNIX system.

Changing license usage on your computer

To change the order in which a product on your computer requests suite and
point-product licenses, use the License Key Administrator’s License Usage Mapper
on Windows systems or the License_Map file on UNIX and Linux systems.

Servers and license usage order

Use the License Usage Mapper on the clients to change the license usage order. To
change the order for Web clients, use the License Usage Mapper on the Web
servers.

If the license server computer is also a client, the license server’s License Usage
Mapper changes only the license usage order for specific user IDs on the client.
(See [‘Changing your license usage order on Windows systems” on page 84| for
more information.) You cannot use the License Usage Mapper on the license server
to change the order for all clients and user IDs.
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Changing your license usage order on Windows systems

You can reverse the changes that you have made to the previous settings by
clicking Restore to Defaults in the License Usage Mapping window.

To change the license usage order on your desktop:

1. Select Settings > License Usage Mapper in the License Key Administrator
menu.

2. In the License Usage Mapping window, make sure that the correct product is
selected in Installed Products. In License Usage Order, the check boxes that
are selected indicate which licenses the license server can check out for the
selected product.

3. Change the order of licenses in License Usage Orderby using the Up and
Down buttons. Ensure the check boxes next to these licenses are selected.

4. Click OK.

Note: The license usage order that you set on your computer is tied to your user
ID. If different users log in to your computer with their own user IDs, the
license usage order that you may have changed resets to the default order.
The new users can set the license usage order for their user IDs. Their
settings do not affect your settings.

Changing your license usage order on UNIX and Linux
systems

The License_Map file is a text file that defines license usage order. A default
License_Map file is created and stored in the config subdirectory when you install
a Rational Suite product. The License_Map file name can be product specific. For
example, Rational PurifyPlus for Linux and UNIX uses the name
PurifyPlus_License_Map.

The file is initially set to claim a suite license for all products. It contains lines of
the following format:

component_designator product_designator {, product designator}

For example, the initial setting in the License_Map file for Rational ClearQuest
should be similar to this:

ClearQuest:1.0 DevelopmentStudioUNIX:1.0, standalone

This line tells a ClearQuest license client to first request a Rational Suite
DevelopmentStudio license. If a Rational Suite DevelopmentStudio license is
unavailable, the client will request a standalone ClearQuest license. Depending on
the Suite product you install, the line you see might differ from the previous
example.

You can modify the settings to customize license usage for all users or for
individual users.

To change the license usage order on your desktop:

1. Run the user setup script (such as rs_setup.csh or rs_setup.ksh) to verify that
the environment variable RSU_LICENSE_MAP is set.
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This environment variable is used to find the location of the correct
License_Map file. If the environment variable is not set, the setup script sets the
pathname to the default license map file, for example, config/License_Map.

2. In the License_Map file, edit the license usage order.
3. Save your changes and close the file.

Note: The license_setup command creates the License_Map file when configured
properly. However, you can create a License_Map file from scratch using a
text file. The file name should match this wild card: *License_Map*.

For more information about the license_setup script, see [Chapter 4
[“Configuring a UNIX license server,” on page 35|
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Chapter 12. Returning or moving keys for desktop users

If you have to upgrade your license keys or move them to another computer, your
license administrator has to perform a floating or authorized user license key
return transaction in License Key Center. Floating and authorized user keys are
tied to a computer’s host ID. Rational products licensed with these keys will not
work until your license administrator registers the products to the new computer.

Returning or removing permanent authorized user keys

Use the return transaction in License Key Center to update the count of registered
products in your account (license pool) before you or your license administrator
requests new license keys.

To return a license key:

1. Your license administrator performs the return transaction in License Key
Center.

2. When you receive the update file from License Key Center, import the file on

your old desktop. Importing the update file completes the return transaction.
For more information, see [“Installing permanent or temporary keys” on page|

Note: Your license administrator can return and import new floating license keys
on the Rational license server.

Moving permanent authorized user keys

Moving a authorized user license key from one desktop to another requires a
return transaction and a new license key transaction in License Key Center. To help
prevent you from confusing the license key update file for the old desktop with
the license key file for the new desktop, ask your license administrator to order
license keys for the new desktop after you receive the update license key file for
the old desktop.

To move a license key from one desktop to another:

1. Your license administrator performs the return transaction in License Key
Center.

2. After you receive the update file from License Key Center, import the file on
your desktop. Importing the update file completes the return transaction. For
more information, see [“Installing permanent or temporary keys” on page 72|

3. Tell the license administrator to order a new license key file in License Key
Center for the new desktop.

4. Remove the Rational software from the old desktop. See the installation guide
for your IBM Rational product for the removal procedures.

5. Install the Rational software on the new desktop.

6. Import the license key file on the new desktop. For more information, see
[“Installing permanent or temporary keys” on page 72

Note: Your license administrator can return and import new floating license keys
on the Rational license server.
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Part 3. Client setup for Rational Software Development
Platform software
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Chapter 13. Before installing license keys

This chapter introduces you to the basic tasks to get your IBM Rational products
built on the Eclipse platform licensed.

able 18] directs you to procedures for entering, importing, and requesting licenses
for your IBM products.

Table 18. Getting started with IBM Rational Common Licensing

Task

Scenario

Procedure

Get your permanent
(or Fixed Term
License) license key.

Fixed Term License
means the license key
has an expiration date
built into it.

You have purchased
floating licenses.

Use your Proof of Entitlement certificate to
request permanent license keys from License
Key Center, the Rational Web-based license
key management tool.

See |Chapter 2, “Requesting license keys,” on|
|Eage 13| for more information about the
License Key Center.

Get your trial license
key.

You want to evaluate
an IBM Rational
product.

Download a copy of the product software
from IBM. The download includes a trial
license key for either 30 or 60 days,
depending on the product.

Install permanent
license keys on your
desktop.

You have purchased
and downloaded a
product enablement
kit for your trial
product.

Use the IBM Installation Manager Manage
Licenses wizard to install your permanent
license keys. The Manage Licenses wizard
imports the new license key and agreement
from the product enablement kit.

See |[Chapter 14, “Installing authorized user|
[license keys,” on page 93| for more
information.

Configure your client
desktop to request
floating licenses from
the license server.

Your license
administrator has set
up an IBM Rational
license server to
serve floating license
keys to desktop
clients.

Get the name of the license server from your
administrator. Then use the Manage Licenses

wizard in the IBM Installation Manager to
specify the license server. See I(_Zhapter 13,|

[“Before installing license keys,” on page 91|

provides page numbers for advanced user tasks that you may have to
perform; for example, you may have to change desktops or you want your client
desktop to request an IBM Rational Software Modeler license before an IBM
Rational Software Architect license in cases where there are shared components.

Table 19. Additional desktop tasks

Task

Procedure

products use licenses.

Change the order in which IBM Rational

Chapter 11, “Changing license usage|
order,” on page 81|

Move or return license keys.

Chapter 12, “Returning or moving keys|
for desktop users,” on page 87

Use license keys for home or travel.

“Using license keys for home use or]
travel” on page 69
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Table 19. Additional desktop tasks (continued)

Task Procedure

Configure UNIX clients. See the IBM Rational product or UNIX
installation guide.

To configure a UNIX license server for Windows |[Chapter 4, “Configuring a UNIX license]
clients. server,” on page 35}

Using license keys for home use or travel

92

If your product uses floating keys, with disconnected mode you can use IBM
Rational software at home for a 3-day period. You must activate disconnected use
within a 3 day period of acquiring a floating license key and disconnecting from
the network at work. After you activate disconnected use, you can use the software
for 3 days from the day and time that you activate the disconnected use.

For example, you acquire a floating key for IBM Rational ClearCase LT at 4 p.m.
on Friday and disconnect from the network and go home. Because you plan to
work at home during the next week, you must activate disconnected use within
the 3-day period of acquiring the key and disconnecting from the network. If you
launch ClearCase LT by 3:30 p.m. on Monday, you can use Rational ClearCase LT
until 3:30 p.m. on Thursday. If you do not launch Rational ClearCase LT before 4
p-m. on Monday, you will lose disconnected use of Rational ClearCase LT.

Disconnected use of floating licenses on a UNIX license server is not supported.

There are two other options for home use or travel:

* Depending on whether it is available for your product, you can use authorized
user keys instead.

* Rational ClearCase LT provides snapshot views. Snapshot views of your work
do not require network connectivity; therefore, a license key is not necessary.

Changing the disconnect time-out to delay disconnected use

If you have a slow network at work, your software automatically goes into
disconnected use mode if it does not receive a response from the license server
within 5 seconds. You then see a window that states that you are in disconnected
use mode after the 5 seconds.

Starting with release 2001A, you can change the time-out period before your IBM

application goes into disconnected use mode. The default setting is 5 seconds. To

change the setting:

1. Create a DWORD key: HKEY_LOCAL_MACHINE\SOFTWARE\IBM
Rational\Licensing\1.0\DisconnectTimeout

2. Modify the value (decimal) to be more than 5 seconds.
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Chapter 14. Installing authorized user license keys

This chapter describes how to install permanent and fixed term license authorized
user license keys on client computers. An authorized user license key is created for
a specific desktop and does not require a license server. Authorized user license
keys enable portability, especially for use scenarios that include isolated computers
or notebooks.

* If you are a client computer user and need to use floating license keys, see
[Chapter 15, “Configuring client computers to use floating keys,” on page 95|

* If you are the license administrator and need to install the floating license keys
on an Rational license server, see (Chapter 3, “Configuring a license server for|
Windows systems,” on page 19| or [Chapter 4, “Configuring a UNIX license]
server,” on page 35|

Opening the IBM Installation Manager to manage licenses

The IBM Installation Manager for Rational Software Development Platform is
installed with your IBM Rational product. Through the Manage Licenses wizard,
the application provides an interface to IBM Rational Common Licensing (powered
by FLEXIm software). Use the Manage Licenses wizard to manage your Floating
license configuration.

* To access the Manage Licenses wizard on a client PC or server, click Start >
Programs > IBM Installation Manager > IBM Installation Manager.

To access the Help, click Help in the IBM Installation Manager main menu.

Reviewing your license information in the Manage Licenses wizard

In the IBM Installation Manager, click File > Open > Manage Licenses.

Installing permanent or Fixed Term License (FTL) keys

Permanent authorized user license keys are included in the product activation kit
that you purchase. You download the product activation kit from Passport
Advantage. The product activation kit file contains license keys and the license
agreement for a specific product.

Importing permanent authorized user keys

Use the Manage Licenses wizard in the IBM Installation Manager to import the
license key file for your desktop PC after you download the activation kit.

For details on importing a product activation kit, see the Help in the Installation
Manager.

© Copyright IBM Corp. 1999, 2007 93



94  IBM Rational : License Management Guide



Chapter 15. Configuring client computers to use floating keys

IBM Rational products that are running on a Windows client PC can check out
floating license keys from a Windows or UNIX license server. This chapter explains
how to specify a license server in your client desktop’s IBM Installation Manager.

Note: Rational License Server version 7.0.0.1 for Windows does not support
serving floating license keys to Rational SDP tools built on the Eclipse
platform. This capability will be available in a future release of Rational
License Server.

In the following situations, you do not have to open the Installation Manager and
specify the license server:

* Your system administrator has set up a silent installation. The silent installation
might include a post-installation command that specifies the license server. For
more information about the silent installation command syntax, see the
installation guide for your IBM Rational product.

* Your administrator might have included the license server name in a site
defaults file in a network release area. When you install the product from the
release area, you do not have specify the license server in your Installation
Manager. For more information about installing IBM Rational products from a
release area, see the installation guide for your IBM Rational product.

* Your computer is also the Rational license server.

If you have a permanent authorized user license that you obtained with a product
activation kit, see [Chapter 14, “Installing authorized user license keys,” on page 93|

Use [[able 20| to guide you through this chapter.

Table 20. Floating license tasks on clients

Task Procedure

Open the Manage Licenses wizard. “Opening the IBM Installation Manager to|
manage licenses” on page 96|

Configure the client PC to use a single |[‘Configuring clients to use Rational license]

or multiple license servers. servers” on page 76|
Configure the client PC to use “Configuring clients to use Rational license|
redundant license servers. servers” on page 76|

Assign a port value when working with |[“Configuring clients to use Rational license]
a firewall situation. servers” on page 76|

Change the license server search order. |[“Configuring clients to use Rational license]
servers” on page 76|

Remove a license server from the search |[“Removing a license server from the server|

order. search order” on page 78
Use floating license keys when you “Using license keys for home use or travel” on|
work at home or travel. page 78|
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Opening the IBM Installation Manager to manage licenses

The IBM Installation Manager for Rational Software Development Platform is
installed with your IBM Rational product. Through the Manage Licenses wizard,
the application provides an interface to IBM Rational Common Licensing (powered
by FLEXIm software). Use the Manage Licenses wizard to manage your Floating
license configuration.

To access the Manage Licenses wizard on a desktop PC or server, click Start >
Programs > IBM Installation Manager > IBM Installation Manager.

To access the Help, click Help in the IBM Installation Manager main menu.

Reviewing your license information in the Manage Licenses wizard

In the IBM Installation Manager, click File > Open > Manage Licenses.

Configuring clients to use Rational license servers

96

Type the license server host name in the IBM Installation Manager of your client.
Consult your license administrator regarding whether the license server has been
started before you specify the license server host name.

Configuring clients to use single or multiple license servers

Use the following procedure to specify one or multiple license servers for your
client PC. Do not use the following procedure to specify redundant servers.

To enter the license server host names on a client PC:
1. In the Installation Manager, click File > Open > Manage Licenses.

2. Select a version of a package, and then select the Configure Floating license
support button.

3. Click Next.
4. Click the Enable Floating license enforcement button.
5. Specify one or more license server connections.

a. Click Add.

b. Type the host name of the license server.

c. (Optional) Type a value in Port for environments where a firewall is used.
Do not assign a value to this port unless your administrator instructs you to
do so.

d. (Optional) You can click the Test Connectionbutton to confirm that the
connection information is correct and that the server is available.

e. Click OK.

f. If your system administrator has given you the host names of additional
license servers, repeat steps a through e above to add each server. For a
redundant servers configuration, where three servers are used, see the
procedure presented later in this chapter.

6. Click Next.

7. (Optional) Configure the license request order for your shell shared or custom
packages. The order of licenses in the list determines the order by which your
software attempts to obtain license keys for a license.

8. Click Finish.
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Your applications request licenses from servers in the order that you enter the
servers in the Manage Licenses wizard of the Installation Manager. If you want to
change this order, see [‘Changing the floating license key usage order” on page 97

Configuring clients to use redundant license servers

Redundant servers are a system of three servers that work together to manage a
single pool of floating license keys. If one of the servers goes down, the other two
license servers automatically continue to manage the license pool.

To specify the redundant license servers on a client PC:

1. In the IBM Installation Manager, click File > Open > Manage Licenses.

2. Select a version of a package, and then select the Configure Floating license
support button.

3. Click Next.

4. Ensure that the Enable Floating license enforcement button is selected.

5. Configure the license server connections.
For a redundant servers configuration, where three servers are used, type each
host name in this format: hostnamel, hostname2, hostname3, where hostname is the

name of the server. For each port number, type accordingly: hostlport#,
host2port#, host3port#, where # is the port number.

6. Click Next, and then click Finish.

Assigning a port value to support a firewall

Assigning a value to the port in Installation Manager is necessary in firewall
situations. Do not assign a value to this port unless your administrator instructs
you to do so. To learn more about Rational licensing and firewalls, see
[floating licenses with a firewall” on page 33| The following procedure assumes the
license administrator has given you the Rational vendor port value.

To assign a port value on a client PC:
1. In the Installation Manager, click File > Open > Manage Licenses.

2. Select a version of a package, and then select the Configure Floating license
support button.

3. For each server you have specified in the table, click Edit.

4. Type the required value in Port. Do not assign a value to this port unless your
administrator instructs you to do so.

5. Click OK.
6. Click Next, and then click Finish.

Changing the floating license key usage order

In some cases, you might want to customize the order by which floating license
keys are used by your installed packages. For example, you might want to have a
shared component in a package search for a specific license key first.

To change the default order for using license keys:
1. In the Installation Manager, click File > Open > Manage Licenses.

2. Select a version of a package and then select the Configure Floating license
support button.

3. Click Next, and then click Next again.
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4. On the License Usage Order page, add a shell-shared package to the list, if
necessary.

a. Click the Add button.
b. Type the package name and version number.
c. Click OK.
5. Select a package name and then click the up or down arrow button to set the
check-out order of the floating license keys. The package name at the top of the

list will request a floating license key for components first. If a license key is
not available, then a license key is requested for the next package in the list.

6. Click Finish.

Changing the server search order

You can change the order by which Rational applications on your client PC access
license servers. The license server list is displayed in the Manage Licenses wizard.
The task of changing the server search order does not affect the order by which
IBM Rational products request licenses from a server. If you have multiple packages
installed that share components in your environment, see [Chapter 16, “Changing]
[license usage order,” on page 101}

If you want to change the server search order, select the license server in the list
and click the Up or Down button to change its position. Click Next, and then click
Finish to complete the change.

Removing a license server from the server search order

If your system administrator tells you that one of the Rational license servers must
go offline, you can remove it from the server search order without deleting the
information from the IBM Installation Manager.

To remove a server from the server search order:
1. In the Installation Manager, click File > Open > Manage Licenses.

2. Select a version of a package, and then select the Configure Floating license
support button.

3. For each server you want to remove from the table, click Remove.
4. Click Next, and then click Finish.

Using license keys for home use or travel

98

If your product uses floating keys, with disconnected mode you can use IBM
Rational software at home for a 3-day period. You must activate disconnected use
within a 3 day period of acquiring a floating license key and disconnecting from
the network at work. After you activate disconnected use, you can use the software
for 3 days from the day and time that you activate the disconnected use.

For example, you acquire a floating key for IBM Rational ClearCase LT at 4 p.m.
on Friday and disconnect from the network and go home. Because you plan to
work at home during the next week, you must activate disconnected use within
the 3-day period of acquiring the key and disconnecting from the network. If you
launch ClearCase LT by 3:30 p.m. on Monday, you can use Rational ClearCase LT
until 3:30 p.m. on Thursday. If you do not launch Rational ClearCase LT before 4
p-m. on Monday, you will lose disconnected use of Rational ClearCase LT.

Disconnected use of floating licenses on a UNIX license server is not supported.
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There are two other options for home use or travel:
* Depending on whether it is available for your product, you can use authorized
user keys instead.

* Rational ClearCase LT provides snapshot views. Snapshot views of your work
do not require network connectivity; therefore, a license key is not necessary.

Changing the disconnect time-out to delay disconnected use

If you have a slow network at work, your software automatically goes into
disconnected use mode if it does not receive a response from the license server
within 5 seconds. You then see a window that states that you are in disconnected
use mode after the 5 seconds.

Starting with release 2001A, you can change the time-out period before your IBM
application goes into disconnected use mode. The default setting is 5 seconds. To
change the setting:

1. Create a DWORD key: HKEY_LOCAL_MACHINE\SOFTWARE\IBM
Rational\Licensing\1.0\DisconnectTimeout

2. Modify the value (decimal) to be more than 5 seconds.
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Chapter 16. Changing license usage order

IBM Rational products request licenses in a specific order. If you have multiple
packages installed that share components in your environment, you need to
understand license usage order and how you can change it. To understand the
explanation in the following sections, you must know the definitions of the license
types. For more information, see [‘Defining license types” on page 6l

Understanding license usage order

When you install IBM Rational products that share components, or shell share, you
can open a product that subsequently checks out a floating license key for another
product. For example, suppose you install Rational Software Modeler and IBM
Rational Software Architect in the same shell, C:\IBM\devtools. Both packages
have been enabled for Rational Common Licensing (powered by FLEXIm software)
to use Floating licenses. When the Rational Software Modeler attempts to check out
a floating license for shared components and fails, it can then attempt to check out
an available license for Rational Software Architect.

You can use the Manage Licenses wizard in IBM Installation Manager to change
the version 7.0 license usage order. You might want to customize the license usage
order in some cases. For example, you might want to have a product search for a
specific license key first.

Changing license usage on your computer

To change the order by which a product on your computer requests suite and
point-product licenses, use the License usage order page of the Manage Licenses
wizard in IBM Installation Manager.

Servers and license usage order

Use the License usage order page of the Manage Licenses wizard on the clients to
change the license usage order. To change the order for Web clients, use the
License usage order page of the Manage Licenses wizard on the Web servers.

Changing your license usage order
To change the license usage order on your client PC:
1. In the Installation Manager, click File > Open > Manage Licenses.

2. Select a version of a package, and then select the Configure license servers
radio button.

3. Click Next, and then click Next again.

4. Change the order of licenses in License usage order by using the Up and
Down buttons.

5. Click Finish.

Note: The license usage order that you set on your computer is tied to your user
ID. If different users log in to your computer with their own user IDs, the
license usage order that you have changed is reset to the default order. The
new users can set the license usage order for their user IDs. Their settings
do not affect your settings.
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Chapter 17. Moving keys for desktop users

If you have to move your IBM Rational software to another computer, the
activation kit must be imported after the new installation.

Moving permanent authorized user keys

If you want to move a product installation with an authorized user license from
one computer to another, you must uninstall the product on the first machine and
reinstall the product on the second machine.

Note: During the unistallation process, the permanent license key is also removed.
Be sure to have your original product activation kit on hand to import the
permanent license key and license agreement to the new computer. If your
activation kit did not come on a CD and you no longer have the
downloaded activation kit, go to Passport Advantage to download another
activation kit using your product order information.

To move a license key from one computer to another:

1. Remove the IBM Rational software from the old computer. See the installation
guide for your IBM Rational product for the removal procedures.

2. Install the Rational software on the new computer.

3. In the IBM Installation Manager, import the license key file from the activation

kit to the new computer. For more information, see [“Installing permanent or
[Fixed Term License (FTL) keys” on page 93]
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Part 4. Appendixes
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Glossary
A

ANY-HOST. A license key issued for ANY-HOST will run on any computer and is not tied to the customer’s
computer ID. Evaluation, temporary, and emergency keys must be configured to run on any computer.

F

Fixed Term License (FTL). Variation of a Permanent key. FTLs are issued to a site to allow employees to use IBM
Rational products for a fixed period of time.

Floating license. A license type that links products to a license server. Client computers obtain licenses from the
license server when they need to run a copy of IBM Rational software. Multiple clients can share the pool of floating
licenses; one license is granted per client per product. Floating licenses on license servers are typically administered
by system administrators.

K

Key type. Authorized user and floating licenses can be enforced by different types of license keys. The types of
license keys are temporary and permanent. Evaluation and emergency keys are variations of temporary keys. Fixed
Term Licenses (FTLs) are a variation of permanent keys. Each type of key has different business rules and policies.

L

License. A legal right to use a product. Customers receive licenses when they purchase IBM Rational products.
However, they need license keys either on a license server or on desktops to actually run the products.

License key. A term used to describe software keys that enable licenses on a customer computer. The types of
license keys are: permanent, temporary, evaluation, emergency, and Term License Agreement (TLA).

License key administrator. A program written by Rational that provides a customer interface to its licensing system.
The License Key Administrator is installed whenever an IBM Rational product is installed on a Windows computer.
For hosting floating licenses, the License Key Administrator is installed when the IBM Rational license server
software is installed on a computer.

License Key Center. The IBM Rational Web-based license management tool. Customers can use this tool to request
permanent license keys and return license keys to their IBM Rational accounts.

License key certificate. A piece of paper or an electronic file that contains information a customer needs to begin
using Rational software with a license.

License key code. An encrypted code used to enforce a license agreement.
License type. The valid types of licenses are authorized user licenses and floating licenses. See also Key Type.

LKAD. Abbreviation for License Key Administrator.

N

Named-user floating. Similar to a floating license type, except that the license administrator assigns licenses to
specific users. That is, only specific users can request floating license keys from the license server. This license type is
only available to customers who purchase Purify, Quantify, and PureCoverage.
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Permanent key . A license that lets customers run IBM Rational products indefinitely. Permanent keys can be
authorized user or floating. Authorized user permanent keys are installed on a client desktop. Floating permanent
keys are installed on a license server.

Note: A Term License Agreement, a variation of a permanent key, does have an expiration date. See Term License
Agreement.

Permanent key code. The encrypted code that lets a customer run a particular IBM Rational product using a
permanent key.

T

Temporary Key. See also Evaluation Key. A short-term license key that lets a customer run IBM Rational software
products. Temporary keys can be authorized user or floating. Authorized user temporary keys are installed directly
on the end user’s machine and provide access to the software for the time period defined in the key. Floating
temporary keys are installed on a license server and run on any host until the specified expiration date.

Temporary Key Code. The encrypted code that lets a customer run a particular IBM Rational product using a
temporary key.

Trial key. A temporary key that lets a customer use and evaluate IBM Rational software for a fixed period of time.
They run on any host and are included with the evaluation copy of IBM Rational software downloaded from
ibm.com® for certain products. Trial keys can be authorized user or floating. A authorized user trial key is installed
directly on the end user’s machine and provides access to the software for the time period defined in the key. A
floating evaluation key is installed on a license server and can allow multiple users to share the key for the time
period defined in the key.

U

User. IBM Rational Common Licensing (powered by FLEXIm software) checks out licenses on behalf of a “user."
The “user” is defined as follows:

* On Windows, the “user” is the Windows operating system log on ID.
* On UNIX, a “user” is the account name of the person running the UNIX shell.

¢ On Web products, the “user” is the product logon ID.

Authorized user license. A type of license that links a product to a computer. Formerly referred to as a node-locked
license. Typically, one authorized user license is issued for each software copy.
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation North Castle Drive
Armonk, NY 10504-1785

USA.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
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programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Department BCFB
20 Maguire Road
Lexington, MA 02421
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

(c) (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. (c) Copyright IBM Corp. _enter the year or years_. All rights

reserved.

Additional legal notices are described in the legal_information.html file that is
included in your Rational software installation.

Trademarks
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AIX, ClearCase, ClearCase Attache, ClearCase MultiSite, ClearDDTS, ClearGuide,
ClearQuest, DB2, DB2 Universal Database, DDTS, Domino, IBM, Lotus Notes,
MVS, Notes, OS/390, Passport Advantage, ProjectConsole Purify, Rational, Rational
Rose, Rational Suite, Rational Unified Process, RequisitePro, RUP, 5/390, SoDA,
SP1, SP2, Team Unifying Platform, WebSphere, XDE, and z/OS are trademarks of
International Business Machines Corporation in the United States, other countries,
or both.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product or service names may be trademarks or service marks of
others.
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Publication No. GI11-6383-01
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